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Warranty

1. LIMITED WARRANTY: Subject to the limitations contained in Section 2 herein and except as otherwise expressly provided
herein, Rosemount Analytical, Inc. (“Seller”) warrants that the firmware will execute the programming instructions provided
by Seller, and that the Goods manufactured or Services provided by Seller will be free from defects in materials or
workmanship under normal use and care until the expiration of the applicable warranty period. Goods are warranted for
twelve (12) months from the date of initial installation or eighteen (18) months from the date of shipment by Seller,
whichever period expires first. Consumables and Services are warranted for a period of 90 days from the date of shipment or
completion of the Services. Products purchased by Seller from a third party for resale to Buyer (“Resale Products”) shall carry
only the warranty extended by the original manufacturer. Buyer agrees that Seller has no liability for Resale Products beyond
making a reasonable commercial effort to arrange for procurement and shipping of the Resale Products. If Buyer discovers
any warranty defects and notifies Seller thereof in writing during the applicable warranty period, Seller shall, at its option,
promptly correct any errors that are found by Seller in the firmware or Services, or repair or replace F.O.B. point of
manufacture that portion of the Goods or firmware found by Seller to be defective, or refund the purchase price of the
defective portion of the Goods/Services. All replacements or repairs necessitated by inadequate maintenance, normal wear
and usage, unsuitable power sources, unsuitable environmental conditions, accident, misuse, improper installation,
modification, repair, storage or handling, or any other cause not the fault of Seller are not covered by this limited warranty,
and shall be at Buyer's expense. Seller shall not be obligated to pay any costs or charges incurred by Buyer or any other party
except as may be agreed upon in writing in advance by an authorized Seller representative. All costs of dismantling,
reinstallation and freight and the time and expenses of Seller's personnel for site travel and diagnosis under this warranty
clause shall be borne by Buyer unless accepted in writing by Seller. Goods repaired and parts replaced during the warranty
period shall be in warranty for the remainder of the original warranty period or ninety (90) days, whichever is longer. This
limited warranty is the only warranty made by Seller and can be amended only in a writing signed by an authorized
representative of Seller. Except as otherwise expressly provided in the Agreement, THERE ARE NO REPRESENTATIONS OR
WARRANTIES OF ANY KIND, EXPRESSED OR IMPLIED, AS TO MERCHANTABILITY, FITNESS FOR PARTICULAR PURPOSE, OR
ANY OTHER MATTER WITH RESPECT TO ANY OF THE GOODS OR SERVICES. It is understood that corrosion or erosion of
materials is not covered by our guarantee.

2. LIMITATION OF REMEDY AND LIABILITY: SELLER SHALL NOT BE LIABLE FOR DAMAGES CAUSED BY DELAY IN PERFORMANCE.
THE SOLE AND EXCLUSIVE REMEDY FOR BREACH OF WARRANTY HEREUNDER SHALL BE LIMITED TO REPAIR, CORRECTION,
REPLACEMENT OR REFUND OF PURCHASE PRICE UNDER THE LIMITED WARRANTY CLAUSE IN SECTION 1 HEREIN. IN NO
EVENT, REGARDLESS OF THE FORM OF THE CLAIM OR CAUSE OF ACTION (WHETHER BASED IN CONTRACT, INFRINGEMENT,
NEGLIGENCE, STRICT LIABILITY, OTHER TORT OR OTHERWISE), SHALL SELLER'S LIABILITY TO BUYER AND/OR ITS
CUSTOMERS EXCEED THE PRICE TO BUYER OF THE SPECIFIC GOODS MANUFACTURED OR SERVICES PROVIDED BY SELLER
GIVING RISE TO THE CLAIM OR CAUSE OF ACTION. BUYER AGREES THAT IN NO EVENT SHALL SELLER'S LIABILITY TO BUYER
AND/OR ITS CUSTOMERS EXTEND TO INCLUDE INCIDENTAL, CONSEQUENTIAL OR PUNITIVE DAMAGES. THE TERM
“CONSEQUENTIAL DAMAGES” SHALL INCLUDE, BUT NOT BE LIMITED TO, LOSS OF ANTICIPATED PROFITS, LOSS OF USE,
LOSS OF REVENUE AND COST OF CAPITAL.
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1 Introducing the 370XA
Topics covered in this chapter:

• General description

• Specifications

• Certifications

This manual contains information pertaining to the Rosemount® 370XA Gas
Chromatograph. The purpose of this manual is to provide detailed installation, operation,
maintenance, and troubleshooting procedures.

1.1 General description
The Rosemount 370XA Gas Chromatograph is the latest analyzer to join the XA series of
Emerson gas chromatographs. Designed to simplify natural gas measurement analysis, the
370XA provides greater ease of use and increased measurement performance for your C6+
BTU/CV analysis.

Another unique benefit of the 370XA is its Maintainable Module™ technology, which
allows you to easily replace the GC module in the field in approximately two hours,
including warm-up and purge, greatly reducing downtime and overall operating costs.
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Rosemount 370XA Gas ChromatographFigure 1-1:   

Structurally, the 370XA has two major sections. The upper section (1) consists of the
analysis module (3). The lower section (2) of the gas chromatograph houses the
electronics (4) and the LCD display.
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1.2 Specifications

370XA electronics specificationsTable 1-1:   

Electronics

Power 24VDC (standard) at the unit.

21-30VDC (operating range) at the unit.

Class 2 power supply as required for CSA approval.

Note: Provide the GC with one 5-amp circuit breaker for protection.

Power consumption at 72 °F (22 °C) 50 Watts (startup)

20 Watts (steady state)

370XA construction specificationsTable 1-2:   

Construction

Environmental temperature -20 °C (-4 °F) to 60 °C (140 °F)

Enclosure protection rating IP65 and Type 4X

Dimensions

(without sample system or mounts)

460 mm (H) x 305 mm (W) x 280 mm (D)

18” (H) x 12” (W) x 11” (D)

Mounting options Pipe, wall

Weight

(without sample system or mounts)

22 kg (50 lbs.)

370XA performance specificationsTable 1-3:   

Performance

Application four-minute C6+ analysis

Repeatability Controlled environment

± 0.0125% calorific value

± 0.125 BTU/scf per 1,000 BTU/scf

-4 °F (-20 °C) to 140 °F (60 °C)

± 0.025% calorific value

± 0.25 BTU/scf per 1,000 BTU/scf

Metrology approvals Measurement Canada, NMi (OIML)

Calculations ISO 6976, AGA-8, GPA 2172 (using the GPA 2145 physical properties table)

Carrier gas Zero-grade helium at 6.2 BarG (90 PSIG).

Zero grade hydrogen available as an option.

Actuation gas Helium, nitrogen, or clean dry air at 6.2 BarG (90 PSIG).

Sample input pressure range 0.7 to 1.7 BarG (10 to 25 PSIG)

Valves Three 6-port diaphragm chromatograph valves.

Oven Airless iso-thermal
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370XA performance specifications (continued)Table 1-3:   

Performance

Detector Thermal conductivity detector (TCD)

Streams One sample stream and one calibration stream

Number of chromatograms stored inter-
nally

Stores up to 88 days of analysis results and up to 2500 individual chroma-
tograms.

370XA standard communicationsTable 1-4:   

Standard communications

Ethernet Two available connections: one RJ-45 plug-in port and one 4-wire termina-
tion. Both with 10/100 Mbps.

Analog input One standard input filtered with transient protection, 4–20 mA that is user
scalable and assignable.

Analog outputs Two isolated outputs, 4–20 mA.

Digital inputs One input that is user assignable, optically isolated, and rated to 30 VDC at
0.5 A.

Digital output One user-assignable output, Form C and electro-mechanically isolated, 24
VDC.

Serial ports Two termination blocks, configurable as RS-232 or RS-485.

1.3 Certifications

Certifications Table 1-5:   

ATEX

Manufacturer Rosemount

Houston, TX, USA

Product 370XA Gas Chromatograph

Certificate number Sira 13ATEX1030

Certification code Ex d IIB+H2 T6 Gb

Ambient range Ta = -20 °C to +60 °C

Serial number device dependent

Year of manufacture device dependent

Warnings DO NOT OPEN WHEN AN EXPLOSIVE ATMOSPHERE MAY BE PRESENT.

DO NOT OPEN WHILE ENERGIZED.

USE SUPPLY CABLES OR WIRES SUITABLE FOR AT LEAST 80 °C.
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Certifications (continued)Table 1-5:   

ATEX

Other markings

Electrical ratings DC: 21 - 30 V, , 55 W MAX

Number and size of the conduit entries 3 conduit entries: M32 X 1.5

EN 60079-0:2009 Explosive atmospheres - Part 0: Equipment - General requirements

EN 60079-1:2007 Explosive atmospheres - Part 1: Equipment protection by flameproof en-
closures "d"

IECEx Equipment for use in explosive atmospheresTable 1-6:   

IECEx Ex d IIB+H2 T6 Gb

- 20 °C to 60 °C

IP65 IECEx CSA 13.0005

CSA certificationsTable 1-7:   

CSA Class I, Div. 1; Groups B, C, D; T6; Type
4X

Class I, Zone 1; Ex/AEx d IIB + H2; T6;
IP65

Introducing the 370XA
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2 Anatomy of the 370XA
Topics covered in this chapter:

• Exterior: Front View

• Exterior: Left View

• Exterior: Right View

• Exterior: Rear View

• Exterior: The local operator interface

• Interior: Back plane

• Interior: Maintainable Module™

2.1 Exterior: Front View

370XA front viewFigure 2-1:   

1. Explosion-proof dome

Unscrew the explosion-proof dome to gain access to the analytical oven.

2. Explosion-proof body

The explosion-proof body houses the electronics.

3. Local operator interface

The local operator interface (LOI) contains keys and an LCD display for interacting
with the gas chromatograph.

Anatomy of the 370XA
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2.2 Exterior: Left View

370XA left-side viewFigure 2-2:   

1. Locking bolt

Secures the dome to the enclosure. To engage the lock, screw in the hex screw with
a 2 mm hex wrench; to release the lock, unscrew the hex screw with a 2mm hex
wrench.

2. Cable entry

M32 conduit entry. This is the most convenient entry point for the power cable. If
this entry is not used for cables then a certified plug must be used.

Certified conduit plugsTable 2-1:   

Certification type Additionally supplied certified parts

CSA M32-to-¾-inch adapter and a ¾-inch sealing plug

ATEX/IECEx M32 plug

3. Grounding lug

Connects to an external grounding system, as required for ATEX-certified
installations.

4. Tubing bulkhead

The central hub for the sample, carrier, and other gas inlets.

Anatomy of the 370XA

8



2.3 Exterior: Right View

370XA right-side viewFigure 2-3:   

1. Upper cable entry

Certified sealing plugsTable 2-2:   

Certification type Additionally supplied certified parts

CSA M32-to-¾-inch adapter and a ¾-inch sealing plug

ATEX/IECEx M32 plug

2. Port hole

Unscrew and remove to gain access to the field wiring connections and the circuit
boards.

3. Lower cable entry

Supplied with an M32 certified plug and an M32-to-¾ NPT adapter. This is the most
convenient entry point for connecting cables to the Ethernet port, communications
ports, and external device terminals. If this entry is not used for cables then a
certified plug must be used.

Certified conduit plugsTable 2-3:   

Certification type Additionally supplied certified parts

CSA M32-to-¾-inch adapter and a ¾-inch sealing plug

Anatomy of the 370XA
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Certified conduit plugs (continued)Table 2-3:   

Certification type Additionally supplied certified parts

ATEX/IECEx M32 plug

2.4 Exterior: Rear View

370XA rear viewFigure 2-4:   

1. Mounting bolts

These M8 bolts are used to mount the GC to its final destination, depending upon
the mounting configuration chosen. Each bolt is 1.8 centimeters long.

Anatomy of the 370XA
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2.5 Exterior: The local operator interface

Local operator interfaceFigure 2-5:   

A. Exit/cancel
B. Alphanumerical keypad
C. Enter
D. Full color screen: 480 x 272 pixels
E. Up
F. Right
G. Select/edit
H. Left
I. Down
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2.6 Interior: Back plane

370XA Backplane boardFigure 2-6:   

TB1. Digital input TB10. Analog outputs (2)

TB2. Analog input RJ-45. Plug-in Ethernet port

TB3. Digital output J8. LOI connector

TB4. COM1 port CPU. CPU board

TB5. Wired Ethernet port ANA. Analyzer board

TB8. 24 VDC power SW1. DHCP switch

TB9. COM2 port

Anatomy of the 370XA
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2.7 Interior: Maintainable Module™

Figure 2-7:   

1. Heater cap

Anatomy of the 370XA

13



Controls the thermal environment surrounding the analytical components of the
module, which is crucial to ensure the reliable and repeatable analysis.

2. Chromatography columns

Separates the sample gas into its component compounds so that they can be
detected and measured. The 370XA's pre-coiled, micro-packed columns contain
active materials that selectively impede the flow of individual component
compounds based on their boiling point, so that components with lower boiling
points take longer to travel through the columns than components with higher
boiling points. The 370XA uses four chromatograph columns and a single restrictor
column.

3. Analytical valves

Manipulates the flow of carrier and sample gases through the columns and the
detector. The analytical valves use diaphragm-actuated pistons to block or release
the flow of the gases between adjacent ports on the valve. The majority of
maintenance on the maintainable module will involve replacing the diaphragms and
cleaning the sealing surfaces of the analytical valves.

4. Detector

Detects and measures the components of the sample gas after the components are
separated by the columns. A single thermal conductivity detector (TCD) has two
thermistors that respond to the difference in thermal conductivity between the
carrier gas and the separated components.

5. Sample shut-off valve

Shuts off the flow of gases to the sample loop for the first five seconds of an analysis
to allow the sample loop to equalize to atmospheric pressure through the sample
vent. This ensures that a consistent amount of sample gas is injected into the
analytical columns each analysis cycle regardless of the sample pressure or flow.

Note
It is good practice to replace the diaphragm of the sample shut-off valve whenever the
analytical valve diaphragms are replaced.

6. Manifold assembly

Most of the components of the analytical oven are mounted on the manifold, which
also contains a multi-layered printed flow-path board (PAFB) that replaces the
interconnecting tubing that traditionally exists between the valves, columns,
solenoids, and detectors.

7. Intelligent module board

To facilitate easy replacement of the maintainable module, its operating and
calibration settings are stored on the intelligent module board (IMB). When a new
maintainable module is installed, it downloads these settings from the IMB. When
the settings are changed, the new configurations are uploaded to the IMB.

8. Stream selection solenoids

Anatomy of the 370XA
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The sample gas stream to be analyzed is selected by a two-way isolation solenoid.
Each stream has a unique stream-selection solenoid. A maintainable module can
have up to three stream-selection solenoids and one calibration solenoid.

9. Carrier gas pressure sensor

Measures the carrier gas pressure as a part of the electronic pressure control.

10. Valve actuation solenoids

Each analytical valve is actuated by its own four-way solenoid. The actuation
solenoid directs the actuation gas to the appropriate pistons in its associated
actuation valve.

11. Carrier gas pressure control valve

Electronically controls the carrier gas pressure.

Anatomy of the 370XA
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3 Installing the 370XA
Topics covered in this chapter:

• Site requirements

• Mounting requirements

• Actions Upon Receipt of GC

• Mount the GC

• Mount the sample conditioning system

• Connect to the carrier gas

• Connect to actuation gas

• Connect to the calibration gas

• Connect to the sample gas

• Electrical connections

• Connect to serial ports

• Connect to Ethernet ports

• Connect to external devices

• Connect to power

• Start up and configure the gas chromatograph

3.1 Site requirements
Consider the following when choosing an installation site for the GC:

• This gas chromatograph is designed to operate at temperatures between -4 ºF (-20
ºC) and 140 ºF (60 ºC).

• Install the GC as close as possible to the sample point but allow for adequate access
for maintenance tasks and adjustments. The analyzer should also be installed to
allow easy access and viewing of the LOI.

• Allow at least 10 inches (254 mm) on the right hand side of the GC to permit access
to the side portal hole where the field terminations are made.

• Allow a minimum of 10 inches (254 mm) above the top of the dome to facilitate
access to the analytical module.

3.2 Mounting requirements
The 370XA can be mounted on a 4-inch pole or onto a wall using one of the mounting kit
options.
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The pole or wall must be able to support at least 50 pounds (20 kg) and withstand the
forces applied when performing routine maintenance, such as removing the oven
enclosure dome.

3.3 Actions Upon Receipt of GC

3.3.1 Unpacking
There are no special unpacking considerations.

3.3.2 Inspection and verification of received equipment
Check the equipment against the packing slip to see if the shipment is complete.

Inspect the equipment for damage incurred during shipment. If any parts or assemblies
appear to have been damaged, do the following:

1. File a claim with the carrier.

2. Take photos of the damaged area(s).

3. Contact your local Rosemount sales representative.

3.4 Mount the GC
The 370XA can be installed in one of the following mounting options:

• Wall mount

• Pole mount

Check the packing slip or the GC’s sales order to learn which mounting hardware was
selected for it.

Note
All options require the same mounting bracket but use different hardware to mount it.

When putting a unit into its final position, be careful to avoid damaging any of the external
components or their attachments. Also, make sure you understand the installation
procedure before handling the unit, and collect the appropriate tools beforehand.

Installing the 370XA
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3.4.1 Minimum installation clearances

Installation clearancesFigure 3-1:   

3.4.2 Mount the GC on a pole
The pole mount arrangement uses a pair of U-shaped pipe clamps and a mounting bracket
to attach the gas chromatograph to a pole that is four inches in diameter.

An optional floor mount is available that is a pole welded to a square base with mounting
holes.

Installing the 370XA

19



Parts

Pole mount partsFigure 3-2:   

1. Mounting bracket

2. 4-inch pipe clamps, each with two nuts

3. Optional 4-inch diameter pole with metal base containing mounting holes suitable
for ½-inch anchors
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Optional gas bottle accessories

Pole mount with accessoriesFigure 3-3:   

1. Carrier gas bottle cradle assemblies (2)

2. Calibration gas bottle cradle assembly
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Dimensions

370XA dimensionsFigure 3-4:   

Instructions
1. Slide the u-bolt plastic inserts (1) onto the pole and place the lower clamp

approximately 1 m (40 inches) from the ground and the upper clamp 27 cm (10¾
inches) above the lower clamp.
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Install plastic u-bolt insertsFigure 3-5:   

2. Slide the two u-bolts (1) into the plastic inserts.
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Install the u-bolts into the plastic insertsFigure 3-6:   

3. Attach the mounting frame to the pole by matching the frame’s mounting holes to
the prongs of the pipe clamps.
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Install mounting frameFigure 3-7:   

4. Tighten the nuts onto the prongs. The mounting bracket should be firmly attached
to the pole.

See Section 3.4.4.

3.4.3 Mount the GC on a wall

Parts

Wall mount bracket partsFigure 3-8:   

1. Mounting bracket

2. Four 7/16” (10 mm) mounting bolts with washers
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Note
You will also need four 10 mm (⅜-in) threaded wall anchors that are capable of supporting at
least 50 pounds (22 kg).

Dimensions

370XA wall mount dimensionsFigure 3-9:   

Instructions

The wall must be able to hold approximately 50 pounds (22 kg).
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1. Install four threaded wall anchors according to the dimensions given in the graphic
below.

Install wall anchorsFigure 3-10:   

2. Place the mounting bracket on to the wall anchors and tighten the mounting nuts.
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Install wall mounting bracketFigure 3-11:   

See Section 3.4.4.

3.4.4 Secure the 370XA to the mounting bracket
1. Screw two bolts, without the washers, into the top mounting holes on the back of

the GC, leaving ½ inch (15 mm) of the thread exposed.

Mounting boltsFigure 3-12:   

2. Maneuver the GC to insert the two top bolts into the eyelets of the mounting
bracket and allow the bolts to drop down and hold the GC loosely on the bracket.
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Aligning the GC with the bracket top boltsFigure 3-13:   

3. Screw in the two bottom bolts through the mounting bracket with the washers on.
The flat washer should be against the bracket, and the spring washer between the
flat washer and the bolt head. Hand tighten these two bolts so that they secure the
GC in place.

4. One at a time, remove the top bolts, put on the washers, and screw the bolts into
the back of the GC and hand tighten.

3.5 Mount the sample conditioning system
There are several sample conditioning systems (SCS) that are available for the 370XA. The
side-mounted single stream SCS includes all of the components required for single stream
natural gas applications on a metal plate that conveniently attaches to the side of the
370XA. For multiple stream applications, several plate-mounted options are available that
can be mounted to a pole, a wall, or a floor stand.

It is also possible to use a third-party SCS. A third-party SCS must contain the following
functional components:

• Moisture drier for the carrier gas

• 2-micron or better particulate filter

• Liquid filter/shut-off

• Flow control to limit the sample flow to between 20 and 50 cc/min
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WARNING!

Using a sample conditioning system that does not include all of these components will
invalidate your gas chromatograph’s warranty.

3.5.1 Attach a single-stream, side-mounted sample
conditioning system to the GC
1. Use the two one-inch bolts and a 5/32 hex wrench to screw the large mounting bar

tightly to the left side of the plate with the angled foot facing the edge of the plate.

Side-mounted single stream sample conditioning systemFigure 3-14:   

2. Use the two half-inch bolts and a 5/32 hex wrench to screw the small mounting bar
loosely to the right side of the plate with the angled foot facing the edge of the
plate.
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Attach the mounting bar to the plateFigure 3-15:   

3. Angle the plate onto the left side of the GC so that the large mounting block fits
behind the left edge of the cut-out. Swing the right side of the plate around until it
attaches to the right side of the cut-out.

Attach the mounting plate to the 370XA GCFigure 3-16:   

4. Slide the small mounting bar (1) to the right so that it fits behind the right edge of
the cut-out. Tighten the small mounting block's screws.
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Secure the mounting bar with the mounting blockFigure 3-17:   

3.5.2 Connect sample conditioning system tubing to the GC
1. Use the tubing supplied with the sample system to connect the stream, calibration,

actuation, and calibration gases from the sample plate to the GC’s manifold block.

Connecting the gases to the sample plateFigure 3-18:   

A. Calibration tubing
B. Sample tubing
C. Actuation tubing
D. Carrier tubing

2. The atmospheric vents should be connected to a vent line of at least ⅜-inch
diameter that is routed to the atmosphere in a safe area to ensure there is no back-
pressure created on the vents.
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Atmospheric vents line connectionsFigure 3-19:   

A. Sample
B. Measure
C. Atmospheric vent
D. Bypass vent

The flows of the vents are:

• Sample Vent - 10 to 50 cc/min of sample gas for approximately 3.5 minutes of
the 4 minute cycle.

• Measure vent - Continuous flow of less than 10 cc/min of carrier gas and 10cc of
sample gas per analysis cycle.

• Sample Bypass - Continuous flow of 150 to 200 cc/min of sample gas.

3.6 Connect to the carrier gas

Carrier gas specificationsTable 3-1:   

Carrier gas Hydrogen or helium

Purity 99.9995% (ultra high)

Moisture content Less than 10 ppm

Hydrocarbon content Less than 0.5 ppm

Supply reserve 90 psi (620 kPaG)

Carrier gas flow Approx. 10 cc/min

Note
The fifth code in the model string of the 370XA engraved on the metal band of the dome indicates
the carrier gas to be used. The letter code HE indicates helium, and H2 indicates hydrogen.
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To ensure the continuous operation of the analyzer, install two high pressure carrier gas
cylinders and connect them to the GC through a manifold arrangement that permits the
replacement of empty cylinders without disrupting the operation of the analyzer.

The manifold arrangement can be a manual valve arrangement or a commercially available
auto switch-over dual regulator assembly.

The following image shows the carrier gas connector (1).

370XA carrier gas connectionFigure 3-20:   

The carrier gas must be regulated from bottle pressure to 90 psi (620 kPa) using a two-
stage bottle regulator with stainless steel diaphragms. Use a dual-stage regulator to
ensure the outlet pressure will not change with changes in the bottle pressure. Stainless
steel diaphragms are required to avoid contamination of the analytical oven. Use ⅛-inch
stainless steel tubing that is clean and free of grease to connect from the carrier gas bottle
manifold to the inlet of the carrier gas drier (1) on the 370XA sample conditioning system
(as shown [show single stream and multi stream panels and indicate inlet of drier]). Before
making the final connection to the sample system, blow through the lines with helium for
30 seconds to remove any contamination such as water or metal shavings from cutting the
tube.

WARNING!

Regulate the carrier gas to 90 psi (620 kPa). Pressures higher than this may damage the
analyzer and cause an unsafe environment.
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3.7 Connect to actuation gas
The analytical valves require actuation gas to operate. When helium is used as a carrier gas,
the default configuration is to also use helium as the actuation gas. When hydrogen is used
as a carrier gas, or if there is a desire to minimize helium usage, another clean dry gas such
as nitrogen or clean-dry air should be used as the actuation gas.

Actuation gas specificationsTable 3-2:   

Moisture content Less than 10 ppm

Particulate Less than 2 microns

Supply pressure 90 psi (620 kPaG)

Note
If you intend to use locally generated instrument air, ensure that the pressure is sufficient and use
filters and dryers to ensure the actuation gas will meet the above specifications in order to avoid
excessive maintenance.

3.7.1 Helium actuation gas
When the carrier gas is also used as the actuation gas, the actuation gas supply connection
should be teed from the helium supply after the moisture filter.

3.7.2 Alternative actuation gas
If a gas other than the carrier gas is to be used as the actuation gas, the supply should be
connected directly to the actuation gas port on the 370XA gas manifold. The actuation gas
should be nitrogen, dry air, or some other non-hazardous gas.

3.8 Connect to the calibration gas
The gas chromatograph requires a high quality, certified calibration gas to ensure accurate
analysis. Although the 370XA is typically set for an automatic daily calibration run in
custody transfer applications, it can be configured with MON2020 for any time frequency,
or set to manual calibration only.

The calibration gas must contain each component that you want to measure. To ensure
that all of the components in the calibration gas remain in the gas phase and that the
composition remains consistent, install a calibration bottle heater blanket and use
insulated or heat-traced stainless steel tubing between the calibration gas and the gas
chromatograph.

The following table recommends the ideal component concentrations for a calibration gas
that can be used with most common natural gas applications. Also provided in the table is
the minimum recommended concentration for each component to ensure an accurate
and repeatable calibration.
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Ideal calibration component concentrationsTable 3-3:   

Component Recommended Concentration

Methane 89.57%

Ethane 5.0%

Propane 1.0%

i-Butane 0.3%

n-Butane 0.3%

2,2 Dimethyl butane 0.015%

neo-Pentane 0.1%

iso-Pentane 0.1%

n-Pentane 0.1%

n-Hexane 0.015%

Nitrogen 2.5%

Carbon Dioxide 1.0%

2,2 Dimethyl butane is the lightest C6+ component and should be added to the n-Hexane
concentration to be entered as the C6+ calibration concentration.

The following image shows the calibration gas connector (1).

calibration gas connectorFigure 3-21:   

Regulate the calibration gas from bottle pressure to 15 psi (100 kPa) using a two-stage
bottle regulator with stainless steel diaphragms. Use a dual-stage regulator to ensure the
outlet pressure will not change with changes in the bottle pressure. Use stainless steel
diaphragms to avoid contamination. Use ⅛-inch stainless steel tubing that is clean and
free of grease to connect from the calibration gas bottle regulator to the calibration gas
inlet connection on the 370XA sample conditioning system (1). Before making the final
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connection to the Sample Conditioning System (SCS), blow through the lines for 30
seconds to remove any contamination, such as water or metal shavings from cutting the
tube.

WARNING!

Do not allow the calibration gas pressure to rise above 30 psi (200 kPa), because doing so may
damage the analyzer and cause an unsafe condition.

3.9 Connect to the sample gas
The sample handling system controls how the gas sample is extracted, conditioned, and
transported to the analyzer and is critical to the accurate and reliable performance of any
gas chromatograph. The basic principles of sample handling are as follows:

• Take a representative vapor sample.

• Control the pressure without causing components to condense.

• Remove particulate and liquid contaminates.

• Transport the sample to the GC while maintaining the composition.

In the typical natural gas application, any liquid or solid contamination in the gas will tend
to accumulate on the inside pipe walls, even if it is clean and dry gas. To take a
representative sample of the flowing gas, insert a sample probe into the center third of the
pipeline. A major flow disturbance in the pipe, such as an elbow fitting or an orifice fitting,
will cause the contaminants to be temporarily mixed with the flowing gas stream;
therefore, if practical, place the probe greater than five pipe diameters from such a flow
disturbance to reduce the amount of contaminants that may be extracted with the gas
sample.

Once the sample is extracted, the gas should be passed through both particulate and
liquid filters to remove any remaining contaminants before it enters the gas
chromatograph.

The following image shows the sample gas connector (1).
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Sample gas connectorFigure 3-22:   

The sample pressure entering the gas chromatograph sample conditioning system should
be between 15 and 30 psi (100 and 200 kPa). If the pressure in the pipeline is higher than
this, regulate the sample pressure to this pressure with a dual stage regulator. Pressure
regulation should occur immediately after the probe, or be combined with the probe (a
regulator probe) because any extended lengths of sample line before the pressure
regulator adds significant lag time, which is the time taken for the sample entering the
probe to reach the analyzer oven.

Note that when the pressure of a gas is reduced, the temperature of the gas will decrease.
This is called the Joules-Thompson effect. If the temperature is reduced below the sample's
hydrocarbon dew point, the higher hydrocarbons will begin to condense and be removed
from the gas phase, which changes the composition of the gas. The analyzed sample will
no longer accurately represent the flowing gas stream.

To avoid this hydrocarbon condensation, heat the regulator and sample lines to the gas
chromatograph to at least 30 °F (17 °C) above the expected temperature of the flowing gas
stream.

Use stainless steel tubing and fittings for all of the sample lines. Use Teflon tape when
making threaded connections in the sample system. Do not use pipe thread compounds.

Once the sample is extracted, the gas should pass through both a 2-micron particulate
filter and a liquid filter/shut-off to remove any remaining contaminants before it enters the
gas chromatograph.

CAUTION!

If the sample system does not contain a 2-micron filter and a liquid filter/shut-off, the GC’s
warranty may be void if it is determined the failure is due to contamination.
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Note
All sample conditioning systems sold with the 370XA include a 2-micron filter for each stream, and a
liquid filter/shut-off can also be purchased separately for each stream.

Observe the following guidelines for installing sample lines:

• Line Length

If possible, avoid long sample lines. In case of a long sample line, flow velocity can be
increased by increasing the sample pressure and by using by-pass flow via a speed
loop.

• Sample Line Tubing Material

Ensure tubing is clean and free of grease.

• Dryers and Filters

- Use small sizes to minimize time lag and prevent back diffusion.

- Install a minimum of one filter to remove solid particles. Most applications
require fine-element filters upstream of the GC. The recommended sampling
system includes a 2-micron filter.

- Use ceramic or porous metallic type filters. Do not use cork or felt filters.

Note
Install the probe/regulator first, immediately followed by the coalescing filter and then
the membrane filter.

• Pressure Regulators and Flow Controllers

- Use stainless steel wetted materials.

- Should be rated for sample pressure and temperature.

• Pipe Threads and Dressings

Use Teflon tape. Do not use pipe thread compounds (dope).

• Valving

- Install a block valve downstream of sample takeoff point for maintenance and
shutdown.

- Block valve should be needle valve or cock valve type, of proper material and
packing, and rated for process line pressure.

3.10 Electrical connections

WARNING!

It is the responsibility of the end user to ensure that all wiring conforms to the local electrical
codes or regulations.
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The 370XA has three cable entries for wiring. If you intend to run the power and
communications cables through a single entry, the lower left entry is the most convenient.
If you intend to run the power and communication cables separately, the lower left entry is
most convenient for the power wiring, and the lower right entry is most convenient for the
communication wiring. The upper right cable entry can be used if there is not enough
space to run all of the wiring through the two lower cable entries.

The cable entries are M32-threaded connections. If your gas chromatograph is CSA-
certified then a certified M32-to-¾-inch conduit adapter and ¾-inch certified plugs will be
shipped with your GC. If your gas chromatograph is ATEX/IECeX-certified then M32-
certified plugs will be shipped with your GC.

The maximum wire size for all of the 370XA’s terminals is 12 AWG or 3.5 mm2. The
terminals can be unplugged from the back plane to make the connection, and then
plugged back into place.

WARNING!

All electrical connections should be made with no power applied.
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3.10.1 Terminal wiring diagram

Terminal board wiring diagramFigure 3-23:   
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3.11 Connect to serial ports
The 370XA has two serial ports on the backplane that can be individually configured for
RS-232 or RS-485 mode using the local operator interface or MON2020. The cables for the
serial communications should be individually shielded pairs with the shield connected to a
clean electrical earth at one end only.

Backplane serial portsFigure 3-24:   

1. COM1

• Modes: RS-232 and RS-485

• Backplane location: TB4

• Supported Modbus formats: ASCII and RTU

2. COM2

• Modes: RS-232 and RS-485

• Back plane location: TB9

• Supported Modbus formats: ASCII and RTU
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3.11.1 RS-232 wiring

RS-232 wiring diagramFigure 3-25:   

• The RS-232 protocol requires a three-wire connection, including a ground and does
not support multi-drop.

• The communication pair should be individually shielded with the shield connected
at one end only.

• There is no need to connect the RTS, CTS, or DTR terminals in most applications.

• The maximum recommended distance for reliable communications with RS-232 is
50 feet (15 meters).

3.11.2 RS-485 wiring

RS-485 wiring diagramFigure 3-26:   
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Note
The terminating resistors shown in the graphic above are not required for most installations but may
help in reducing communication errors for long distance or multi-dropped applications.

• The RS-485 protocol is suitable for longer distance communications and also allows
multi-dropped communication to multiple devices.

• For long distance RS-485 communications, wire 100 ohm to 120 ohm terminating
resistors in parallel to the two endpoint terminals.

• If the GC is connected with multiple devices on an RS-485 link, terminating resistors
should only be installed at the two end points.

3.12 Connect to Ethernet ports

Ethernet ports on the backplaneFigure 3-27:   

1. Ethernet 1

• Backplane location: J9

• Terminal type: RJ-45, DHCP-enabled

2. Ethernet 2

• Backplane location: TB5

• Terminal type: Wired

3. DHCP switch

• Back plane location: SW1
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The 370XA has two Ethernet ports that can be configured with unique IP addresses, subnet
masks, and gateway addresses.

• Ethernet 1 is an RJ-45 connector designed to accept common Ethernet cable
connections found on computers and other Ethernet enabled devices and is
primarily intended for local connection to a computer, but can also be permanently
connected to other Ethernet devices.

• Ethernet port 2 is a field terminated port primarily intended for connection to
supervisory systems or other Ethernet enabled devices.

• Both ports can be used for MODBUS TCP communication and communication to the
MON2020 configuration and diagnostics software.

Note
You can establish up to 10 simultaneous Modbus TCP connections from the Modbus master.
Connections attempts made after the ten connection will be ignored.

3.12.1 Ethernet 1 port
Ethernet 1 was designed primarily for local connection to a computer, such as a
technician's laptop, for occasional maintenance and diagnostic purposes. The connector is
the same RJ-45 Ethernet connector commonly found on most Internet-capable devices.

The RJ-45 port has a DHCP server that will automatically assign an Internet Protocol (IP)
address to a computer when it is connected to the port. There is a switch at SW1 on the
back plane that turns the server on and off.

Note
If your computer is not configured to automatically configure Ethernet settings, contact your IT
department for instructions on how to change your IP settings to an address in the same range as the
Ethernet subnet on the GC, or to obtain an IP address and subnet for the 370XA that will work with
your computer's settings.

If Ethernet 1 port is to be wired to other Ethernet-enabled devices, such as a router, hub, or
local area network, then set the DHCP server switch to OFF to ensure that the operation of
the network is not affected.
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3.12.2 Ethernet 2 port

Ethernet 2 port on the backplaneFigure 3-28:   

The second Ethernet port is intended to be connected to an Ethernet-enabled supervisory
network such as a flow computer, Supervisory Control and Data Acquisition (SCADA)
system, or Distributed Control System (DCS). This port can also be used to permanently
connect to a maintenance network with MON2020.

Since this port is intended for connection to hard wired Ethernet networks, the IP address,
the subnet, and the gateway address must be configured appropriately for the network
connection. Consult with your network administrator for the required settings.

3.13 Connect to external devices

Digital and Analog device connectionsFigure 3-29:   
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1. Digital input (TB1) 3. Analog input (TB2)

2. Digital output (TB3) 4. Two analog outputs (TB10)

3.13.1 Digital inputs
The discrete digital input can be configured to trigger alarms, change the stream
sequence, or other functions. The input is optically isolated and can accept either a contact
closure such as a pressure switch or a DC voltage signal between 5 and 30 VDC at 1 Amp.

Wiring diagram for a digital input connected to a contact closure deviceFigure 3-30:   

Wiring diagram for a digital input connected to a voltage output device
such as a flow computer

Figure 3-31:   

3.13.2 Digital output
The digital output is a Form C dry contact relay output with normally open and normally
closed contacts. The output is typically configured as an alarm output, but can be
configured for other purposes. When using the digital output as an alarm output, it is
important to configure the circuit for fail-safe operation, which means that the “normally
open” contact should be used and configured so that a power failure will raise an alarm in
the connected device.
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Wiring for a digital output for fail-safe modeFigure 3-32:   

3.13.3 Analog input
You can use the analog input to monitor and generate an alarm from an external signal,
such as a pressure transmitter on the carrier gas bottles or as a composition component
input from another analyzer, such as a moisture or H2S analyzer. The analog input is
optically isolated and requires external loop power.

Analog Input wiring with an external power supply and a loop powered
transmitter

Figure 3-33:   

3.13.4 Analog outputs
The 370XA has two analog outputs. Each analog output can be used to transmit a GC
variable, such as an energy value or a component concentration, as a 4 to 20 mA signal.
The outputs are self-powered and require a loop resistance of less than 500 ohms.
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An analog output connected to an ROC800 analog input cardFigure 3-34:   
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3.14 Connect to power

Power source wiringFigure 3-35:   

3.14.1 Power source wiring
Follow these precautions when installing power source wiring:

• All wiring, as well as circuit breaker or power disconnect switch locations, must
conform to all national standards as well as all local, state, or other jurisdictions.

• Provide the GC with a 5 Amp circuit breaker for protection.

• To operate correctly the 370XA requires at least 21 VDC at the terminals on the
backplane. When wiring for DC power connections, you must account for the
voltage drop due to the resistance of the cable. The following tables estimate the
voltage drop and the maximum length of cable with a 24 VDC supply at the
maximum power draw, while the analytical oven heats up during startup, of 55 W.

Voltage drop for AWG cable length Table 3-4:   

American Wire Gauge (AWG) size 12 14 16

Resistance per 1000 feet 1.62 2.58 4.08 Ohms

Voltage drop per 1000 feet at 2.5 A 4.05 6.44 10.21 VDC
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Voltage drop for AWG cable length (continued)Table 3-4:   

Maximum length (3 VDC power Drop) 740 465 293 Feet

Voltage drop for Metric Wire Size cable length Table 3-5:   

Metric Wire Size 2.5 1.5 mm2

Resistance per 100 m 1.3 2.1 Ohms

Voltage drop at 100m at 2.5 A 3.25 5.25 VDC

Maximum length (3 VDC power Drop) 92 57 meters

3.14.2 Electrical and signal ground
Follow these general precautions for grounding electrical and signal lines:

• On ATEX-certified units, the external ground lug (1) must be connected to the
customer’s protective ground system via 9 AWG (6 mm2) ground wire. After the
connection is made, apply a non-acidic grease to the surface of the external ground
lug to prevent corrosion.

External ground lug locationFigure 3-36:   

• The equipment-grounding conductors used between the GC and the copper-clad
steel ground rod must be sized according to your local regulations.

3.15 Start up and configure the gas chromatograph

3.15.1 Apply carrier and actuation gas
If the carrier gas and actuation gas are the same supply, start them together.

If a separate actuation gas supply is being used, apply pressure and leak check the
actuation gas first, and then repeat for the carrier gas.
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CAUTION!

Applying carrier gas without actuation gas can result in a direct path of the carrier gas to the
vent that will rapidly use up the carrier gas supply.

1. Back off the bottle regulator so that when the bottle valve is opened, there will be no
pressure applied.

2. Open the bottle valve.

3. Slowly increase the regulated pressure to 90 psi (620 kPa).

4. Leak check the lines from the bottle to the GC.

3.15.2 Apply calibration gas
1. Close the calibration gas isolation valve on the sample handling system.

2. Back off the bottle regulator so that when the bottle valve is opened, there will be no
pressure applied.

3. Open the bottle valve.

4. Slowly increase the regulated pressure to 15 psi (100 kPa).

5. Leak check the lines from the bottle to the GC.

Note
Do not open the isolation valve to the calibration gas yet. This will be done during the startup
of the GC.

3.15.3 Apply sample gas
Perform the following procedure for each sample line.

1. Close the sample isolation valve on the sample handling system.

2. Back off the sample regulator so that when the sample point isolation valve is
opened, there will be no pressure applied.

3. Open the sample point isolation valve.

4. Slowly increase the regulated pressure to 15 psi (100 kPa).

5. Leak check the lines from the bottle to the GC.

Note
Do not open the isolation valve to the calibration gas yet. This will be done during the startup
of the GC.

3.15.4 Turning on power for the first time
At this point, actuation gas and carrier gas should be flowing through the GC. The GC can
take up to two hours to heat up to temperature, during which time the software settings
can be configured and the system purged.
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1. Turn on the power supply to the GC. The local operator interface’s bootup screen
displays. When the Home screen displays, bootup is complete. The bootup process
takes less than three minutes.

2. Wait fifteen minutes.

A red alarm icon should be visible in the lower right corner of the Home screen.

3. Press 2 on the keypad to open the Alarms screen.

Note
You may be required to log in first. The default login values are:

User: emerson

Password: [blank]

4. Confirm that the alarm that was triggered was the Heater 1 Out Of Range alarm.
Other possibe alarms are the GC Idle alarm, Carrier Pressure Low alarm, and the
Power Failure alarm.

Note
If the Current Alarms screen displays the Carrier Pressure Low alarm, confirm that the
carrier gas supply is on and that the pressure regulator is set to 90 psi (620 kPa). If the alarm
persists, see the Troubleshooting section. Because this is the first time that the GC has been
turned on, the other alarms can be ignored.
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5. Press 2 to acknowledge and clear the alarm.

Note
The Heater 1 Out Of Range alarm will reappear every fifteen minutes until the GC reaches its
temperature setpoint. Continue to press 2 as necessary.

6. Press the Exit key to return to the Home screen.

3.15.5 Set the time
1. Press the Enter key to go to the Main Menu.

2. Use the right arrow key to move to the Tools menu.

3. Use the down arrow key to move to the Set GC Time command and press the Enter
key. The Set GC Time screen displays.

4. Set the current date and time.

• Press the Edit key to activate a field.

• Use the numeric keys to enter the date and time.

• Press the Enter key to accept an entry and to de-activate the field.

• Use the arrow keys to move to the next field.

5. If your country employs daylight savings time, select the Enable Day Light Savings
check box, which is unselected by default.

Note
You must use MON2020 to configure daylight savings time.

3.15.6 Configure the gas chromatograph’s Ethernet ports
1. Go to the Main Menu and select TCP/IP on the Application menu.

The TCP/IP screen displays.

2. Make a note of the Ethernet settings for both ports.

Ethernet 1 is the RJ-45 terminal that is commonly used for local computer access;
Ethernet 2 is the port that is commonly used for communication with a supervisory
system such as a flow computer, Remote Terminal Unit (RTU), SCADA, or DCS.

3. Enter the Ethernet settings according to the network requirements of your
installation.

If you intend to use Ethernet 1 for local access only, do not change the settings.
Contact your network administrator or the person in charge of configuring your
supervisory system network for the settings required to connect the GC to your
network.
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3.15.7 Connect a computer directly to the 370XA
The Ethernet 1 port uses a common RJ-45 connector for connections between local
devices and includes a Dynamic Host Configuration Protocol (DHCP) server that
automatically configures the settings of a computer when it connects to Ethernet 1.

Switch on the DHCP server for a local, single-computer connection, or switch it off if you
intend to connect Ethernet 1 to multiple devices on a local area network (LAN).

3.15.8 Connect a local computer to the 370XA
1. Locate the switch at SW1 (1) on the backplane. It is in front of the RJ-45 Ethernet

plug (2). Flip the switch on. This activates the GC's DHCP server. The server typically
takes 20 seconds to initialize and start up.

Backplane switches and RJ-45 connectorFigure 3-37:   

Note
If you intend to connect the RJ-45 port to a router or switch, ensure the GC's DHCP server is
turned off by flipping the SW1 switch to OFF. Connecting to your LAN with the DHCP server
on will disrupt your local network's functioning.

Note
The GC can be connected (or remain connected) to a local network via the wired Ethernet 2
port on the back plane while the DHCP feature is being used.

2. Connect between the GC's RJ-45 connector and the local computer with a standard
Cat 5 Ethernet cable.

3. Wait 30 seconds for the computer to update its TCP/IP settings.
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Note
If your computer is not configured for dynamic IP addressing (static IP), you will need to
configure the 370XA with a static IP address that is in the same subnet as your computer.
Contact your network administrator for these IP settings and enter the required settings into
the TCP/IP Settings screen on the 370XA.

4. Start MON2020.

Note
You must have at least MON2020 version 3.0 to communicate to the 370XA.

5. Select Connect on the Chromatograph menu.

The Connect to GC window opens.

6. Click the Ethernet button in the Direct-DHCP row.

The Login screen opens.

7. Enter your login information and press OK.

The computer will connect to the GC. The status bar at the bottom of the MON2020
screen will show the GC name, the alarm status, the mode and the time and date of
the connected GC.

3.15.9 Configure the serial communications settings from the
LOI
To configure the serial port communication settings to communicate with ModBus host
devices such as a flow computer, RTU, SCADA, or DCS, the protocol settings for all the
devices on the network must match. Obtain the required serial port settings prior to
configuring the settings on the GC.

1. Go to the Main Menu and select Communications on the Application menu. The
Communications screen opens.

2. Enter the serial port settings.

• Modbus ID - The address that the host device will use to communicate with the
GC. For applications where the GC is the only slave device on the network, the
ModBus ID is typically set to 1. For multi-dropped applications where the GC is
one of several on the serial network, the ModBus ID needs to be unique. Refer to
your host device configuration to determine the ModBus ID to be configured on
the GC.

• Baud Rate - The baud rate can be set at the standard rates from 1200 baud up to
57600. For ModBus communications, the typical setting is 9600.

• Data Bits - The number of bits used for communications. The typical setting for
ASCII mode communications is 7. The typical setting for RTU mode
communications is 8.
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• Stop Bits - The number of bits sent to indicate the end of a message. Typically
set to 1.

• Parity - The error checking mode for the parity bit in ASCII mode messages. This
can be set to either ODD or EVEN for ASCII mode communications and must
match the host device’s setting. Set to NONE for RTU mode communications.

• MAP File - The ModBus address map. By default, this is set to SIM_2251, which is
a pre-configured map with the same mapping as the Daniel 2251 controller, and
is the most common communication mapping for flow computer-to-GC
communications. Refer to the MON2020 manual to learn more about
configuring custom maps.

• Port - The selection between RS-232 and RS-485 physical layer communication
protocol.

Note
The 370XA does not have a setting for ASCII or RTU mode. The GC automatically detects the
mode during its initial communications with the host device and automatically selects the
correct mode.

3.
Press  to save the changes and return to the Main Menu.

3.15.10 Set the calibration gas concentration values

Note
You can use MON2020 to enter these values. Select Component Data from the Application menu.

1. Go to the Main Menu.

2. Move to the Application menu and select Calibration Gas Info.

The Calibration Concentration screen displays.

3. Enter the concentration values that are written on the calibration gas’ certificate
into the appropriate fields on the Calibration Concentration screen.

Note
If the Auto Calculate Methane check box is selected, the Methane value will be calculated
based on the values entered in the other fields. This value updates after each new entry.

4. If the calibration gas’ certificate displays a Methane value, compare the value to the
Calibration Concentration screen’s Methane value. If the values do not match,
confirm that you have entered the other values correctly.

5.
Press .

The Uncertainty % screen displays.
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6. Enter the uncertainty values from the calibration gas’ certificate into the appropriate
fields on the Uncertainty % screen.

Note
If the calibration gas certificate does not list the uncertainty percentages, enter the default
value of 2.

7.
Press .

The Cal Gas Certificate CV screen displays.

8. Enter the Cal Gas Certificate CV and CV Check Deviation values from the calibration
gas’ certificate.

Note
The GC calculates the energy content using the C6+ ratio configured in the GC at the factory.
Because the energy content data on the calibration certificate is typically calculated using the
energy value of the actual components in the mixture, there may be a difference between the
GC’s energy values and the calibration certificate’s energy values. If the values don’t match,
enter the calculated values from the GC to ensure the energy value check during the
calibration runs will not cause nuisance alarms.

9.
Press .

For other configuration settings, refer to the Advanced Configuration section.

3.15.11 Calibrating the GC for the first time
1. Open the Heater screen.

2. Confirm that the Temperature for Heater 1 matches the Setpoint and the Current
PWM is less than 40. If not, see the Troubleshooting section.

Note
The Current PWM shows the percentage of time power is applied to the heater. Values under
40 indicate a stable temperature has been reached. If a stable temperature has not been
reached three hours after the power was applied, refer to the troubleshooting guide.

3.
Press to close the screen.

4. Go to the GC Control menu and select Single Stream.

The Start Single Stream Analysis screen displays.

Note
You may be asked to log in first.
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5. Select the calibration stream by clicking the Edit button and using the arrow keys to
highlight 4-Cal, and clicking the Edit key again.

6. Make sure the Purge Stream for 60 seconds and the Continuous Operation check
boxes are selected.

7.
Press to start the analysis.

8.
Press to return to the Home screen.

Note
The first few analysis runs will show a chromatogram on the Home screen that may not look
normal. This is common for the first runs after the unit has been started up after an extended
amount of down time.

9. Let the analysis run for 30 minutes and then go to the GC Control menu and select
Halt.

10. Wait for the analysis cycle to finish and the mode change to Idle.

11. Return to the GC Control menu and select Calibration.

The Start Calibration screen displays.

12. Make sure the Purge Stream for 60 seconds and the Normal check boxes are
selected.

13.
Press  to start the calibration.

14. Wait for the calibration cycle to complete. By default, this will run for 3 analysis
cycles for a total of 13 minutes, including the 60-second purge.

Note
If the calibration generated any alarms go to the Current Alarms screen to view them. Refer to
the troubleshooting section to learn how to resolve the calibration issues.

15. Open the isolation valves for the sample stream(s) and set the pressure to between
15 and 30 psi (100 to 200 kPa).

16. Go to the GC Control menu and select Auto Sequence.

The Start Auto Sequence screen displays.

17. Make sure the Purge Stream for 60 seconds check box is selected.

18.
Press to start the analysis.

19. Go to the View menu and select Reports.

The Report Display screen displays.

20. View the Analysis Report for each stream and confirm that the un-normalized total is
between 98 and 102. If it is not, refer to the Troubleshooting section.
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The gas chromatograph is now running and analyzing the sample streams. It will
automatically calibrate once a day with the default settings, so the calibration gas must
remain on. Refer to the Advanced Configuration and Operation section for further
information and configuration instructions.
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4 Using the 370XA
Topics covered in this chapter:

• Interacting with the LOI

• How to perform common tasks with the LOI

• LOI screen descriptions

• The GC Control menu

• The Tools menu

• Advanced configuration and operation topics

You can perform many routine maintenance functions directly from the LOI. In most cases,
the 370XA can be installed, configured, and placed on line without the use of a computer.

4.1 Interacting with the LOI
The LOI automatically starts up when the GC is turned on. The LOI displays the Startup
screen, which updates with its start up status. After the firmware has booted up, the LOI
will display the Home screen.

To edit data, you must be logged in at the appropriate security level; if you attempt to edit
data without being logged in, the Login screen will appear.

You will be logged off automatically after a period of 15 minutes of inactivity. The LOI will
turn off the back light and return to the Home screen.

4.1.1 Menu operation

To view the Main Menu from the Home screen, press Enter ( ). Use the arrow keys to
navigate through the menus.

To exit from the Main Menu and return to the Home screen, press Exit ( ). If you were
logged on when exiting the menu, you will be logged off.
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4.1.2 Screen operation
Use the up and down arrow keys to navigate between a screen’s fields. Pressing the down
arrow key while focus is on the last field on the screen will move the focus to the first field
on the screen; alternatively, pressing the up arrow key while focus is on the first field on
the screen will move the focus to the last field on the screen.

Select/Edit. Puts the field currently in focus into edit mode, unless the focus is on a table,
in which case pressing this key allows you to navigate amongst the table’s cells.

If there is no field in edit mode, you can exit that screen in one of two ways:

Enter. If you made any changes to the screen’s data, the LOI validates and saves them,
while also generating the appropriate event log entries. The LOI then exits the current
screen.

Exit. If you made any changes to the screen’s data, the LOI discards the changes and exits
the current screen.

4.1.3 Entering numeric data
The valid key entries for numeric data are the numbers 1 - 9, the negative sign (-), and the
decimal point (.).

The decimal point is only available for floating-point numbers.

Press  to put the numeric field into edit mode.

Press  to validate and save new data.

Press  to cancel the new data and keep the original data.

Press the left arrow key to delete the digit immediately to the left of the currently
highlighted number.
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Press the right arrow key to move the cursor to the right one space.

4.1.4 Enter alphanumeric data
To enter a letter into an alphanumeric field, press the appropriate key to cycle through its
alphanumeric options until the desired letter appears. For example, to enter an “H”, you
must press the 4GHI key three times.

4.2 How to perform common tasks with the LOI

4.2.1 Acknowledge an alarm
1. Go to the Current Alarm screen. This can be done in one of two ways:

• From the Home screen, press 2 on the keypad.

• From the Main Menu, navigate to the View menu and select Current Alarms.

2. From the Current Alarms screen, use the up and down arrow keys to move to the
alarm that you want to acknowledge.

3.
Press .

The alarm will be acknowledged.

4.2.2 Acknowledge all alarms
1. Go to the Current Alarms screen. This can be done in one of two ways:

• From the Home screen, press 2 on the keypad.

• From the Main Menu, navigate to the View menu and select Current Alarms.

2. Press 1 on the keypad.

All alarms will be acknowledged.

4.2.3 Acknowledge and clear all alarms
1. Go to the Current Alarms screen. This can be done in one of two ways:

• From the Home screen, press 2 on the keypad.

• From the Main Menu, navigate to the View menu and select Current Alarms.

2. Press 2 on the keypad.

The alarms will be acknowledged and cleared from the GC and the screen.
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4.2.4 View the maintenance log
1. Go to the Main Menu. This can be done in one of two ways:

•
From the Home screen, press .

•
From any other screen, press .

2. From the Main Menu screen, use the left or right arrow keys to move to the Logs
menu.

3. Use the down arrow to highlight the Maintenance Log command.

4.
Press .

The Maintenance Log screen displays.

4.2.5 View the event log
1. Go to the Main Menu. This can be done in one of two ways:

•
From the Home screen, press .

•
From any other screen, press .

2. From the Main Menu screen, use the left or right arrow keys to move to the Logs
menu.

3. Use the down arrow to highlight the Event Log command.

4.
Press .

The Event Log screen displays.

4.2.6 View a live chromatogram
Live chromatograms display on the Home screen by default, but there are two other ways
of viewing a live chromatogram on its own screen.

Method #1

From the Home screen, press 4 on the keypad. The Live CGM screen displays.

Method #2

1. Go to the Main Menu screen. This can be done in one of two ways:

•
From the Home screen, press .

•
From any other screen, press .
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The Main Menu displays with the View menu selected.

2. From the View menu, use the down arrow to highlight the Chromatogram
command.

3.
Press .

The CGM Settings screen displays. The live chromatogram is at the top of the list
and has an icon beside it.

4.
Press .

The Live CGM screen displays.

4.2.7 View an archived chromatogram
1. Go to the Main Menu screen. This can be done in one of two ways:

•
From the Home screen, press .

•
From any other screen, press .

The Main Menu displays with the View menu selected.

2. From the View menu, use the down arrow to highlight the Chromatogram
command.

3.
Press .

The CGM Settings screen displays.

4. Press the down arrow key to move from the live chromatogram and to select the
archived chromatogram that you want to display.

5.
Press .

The Archived CGM screen displays.

4.2.8 Start a single stream analysis run
1. Go to the Main Menu screen. This can be done in one of two ways:

•
From the Home screen, press .

•
From any other screen, press .

2. From the Main Menu screen, use the left or right arrow keys to move to the GC
Control menu.
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3. Press the down arrow to highlight the Single Stream command.

4.
Press .

The Start Single Stream Analysis screen displays.

5. Press the down arrow key to highlight the stream that you want to analyze.

The Purge stream for 60 seconds feature allows sample gas to flow through the
sample loop for 60 seconds prior to beginning the first analysis. The feature is
checked by default.

The Continuous operation feature allows for the repeated analysis of the selected
stream. The feature is checked by default.

6. To select or clear the Purge stream for 60 seconds check box or the Continuous
operation check box, do the following:

a. Press the down arrow key to move from the Stream list box to the Purge stream
for 60 seconds check box.

b. To select or clear the Purge stream for 60 seconds check box, press

.

c. Press the down arrow key to move from the Purge stream for 60 seconds check
box to the Continuous operation check box.

d.

To select or clear the Continuous operation check box, press .

7.
Press  to start the analysis run.

4.2.9 Start a calibration analysis run
1. Go to the Main Menu screen. This can be done in one of two ways:

•
From the Home screen, press .

•
From any other screen, press .

2. From the Main Menu screen, use the left or right arrow keys to move to the GC
Control menu.

3. Press the down arrow to highlight the Calibration command.

4.
Press .
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The Start Calibration screen displays.

5.

Press .

6.
Press .

The Purge stream for 60 seconds feature allows sample gas to flow through the
sample loop for 60 seconds prior to beginning the first analysis. The feature is
checked by default.

There are two types of calibration:

• A Normal calibration is a manual calibration in which the newly computed
calibration factors are updated to the CDT only if the deviation with previous
factors don't exceed limits set in the CDT. This is the default option.

• A Forced calibration is a manual calibration in which the component data table for
the selected stream is updated with calibration factors even if that data is outside
the acceptable deviations that are listed in the component data table.

7. To select or clear the Purge stream for 60 seconds check box, do the following:

a. Press the down arrow key to move from the Stream drop-down list to the Purge
stream for 60 seconds check box.

b. To select or clear the Purge stream for 60 seconds check box, press

.

c.
If you do not want to select a calibration type, press  and the calibration
starts.

8. To select a calibration type, do the following:

a. Press the down arrow key to move from the Purge stream for 60 seconds check
box to the set of Calibration Type check boxes.

The Normal check box will be selected.

b. If you want to select Forced, press the down arrow key and it will be selected.

c.
Press  to start the calibration run.

Using the 370XA

67



4.3 LOI screen descriptions

4.3.1 The View menu

The Current Alarms screen

Current Alarms screenFigure 4-1:   

1. Check box

Select the alarm’s check box in order to acknowledge it.

2. State

Indicates whether the alarm is active ( ), unacknowledged ( ), or inactive (blank).

3. Date/Time

Indicates the date and time at the GC when the alarm condition occurred.

4. Alarm Message

Describes the alarm.

The Reports screen

Report Display screenFigure 4-2:   
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1. Select Report

Lists the report types that can be generated and displayed by the LOI.

2. Select Stream

Select the stream that was analyzed.

The Report Viewer screen

This window displays after you select a report type from the Reports screen. This screen's
content is dependent upon the type of report selected.

Report Viewer screenFigure 4-3:   

The Chromatogram screens

Select Chromatogram screenFigure 4-4:   

The CGM Viewer screen displays when you select Chromatogram from the View menu.
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Chromatogram Viewer - Live CGMFigure 4-5:   

Section Label Description

Select CGM The LOI can display a live or an archived chromatogram, but not both. The
chromatograms listed in the Archived drop-down list are sorted by date,
with the newest file listed first.

Scale Allows you to enlarge or shrink the chromatogram.

4.3.2 The Hardware menu

The Heaters screen

Heaters screenFigure 4-6:   

Label

The heater’s name. This can be changed with MON2020.

Switch

Indicates the state of the heater:
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• Auto: The heater is controlled by the GC.

• Fixed On: The heater is controlled manually, through user input.

• Not used: The heater is shut off.

The switch state can be changed with MON2020.

Setpoint (C)

Indicates the target temperature. The setpoint and the unit of measurement (Celsius or
Fahrenheit) can be changed with MON2020.

Temperature (C)

Indicates the current temperature.

Current PWM

Indicates the current percentage of power being provided to the heater.

Status

Indicates the operational state of the heater.

• OK: The heater’s control card is installed and is working correctly.

• Not installed: The heater is not installed.

• Out of Control: The heater is running but the temperature is not within control
limits.

• Error: The GC cannot communicate with the heater.

The Valves screen

Valves screenFigure 4-7:   

1. Label

The name of the valve as set in MON2020.
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2. Mode

There are three modes:

• Auto - The valve’s on or off state is controlled by the GC.

• Off

• On

The mode can be set by the user.

3. Status icon

Green means that the valve is on, or active; gray means the valve is off, or inactive.

The EPC screen

EPC screenFigure 4-8:   

Label

The name of the EPC as set in MON2020.

Switch

• Auto: The EPC is controlled by the GC.

• Fixed On: The EPC is controlled manually, through user input.

• Not used: The EPC is shut off.

Set Point

Indicates the target pressure.

Fixed PWM Output

The desired percentage of power to provide to the EPC.

Current PWM

Indicates the current percentage of power being provided to the EPC.
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Current Value

The current pressure.

Status

Indicates the operational state of the EPC.

• OK: The EPC is installed and is working correctly.

• Out of Range: The EPC is running but the pressure is not within control limits.

• Error: The GC cannot communicate with the EPC.

The Discrete Input screen

Discrete inputs screenFigure 4-9:   

Label

The name of the discrete input as set in MON2020.

Switch

Indicates the discrete input's operational mode. There are three modes:

• Auto - The discrete input’s on or off state is controlled by the GC.

• Off

• On

The mode can be set by the user.

Invert Polarity

The Invert Polarity option reverses the way a voltage signal is interpreted by the discrete
input. By default, the Invert Polarity option is set to Normally Open, which means that a low
voltage signal is interpreted by the discrete input as ON, and a high voltage signal is
interpreted by the discrete input as OFF. Setting Invert Polarity to Normally Closed means
that a low voltage signal is interpreted by the discrete input as OFF, and a high voltage
signal is interpreted by the discrete input as ON.
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This option can be changed with MON2020.

Current Value

Indicates the current state of the discrete input. Options are On and Off.

The Discrete Outputs screen

Discrete Outputs screenFigure 4-10:   

Label

The name of the discrete output as set in MON2020.

Usage

A discrete output’s usage mode determines which signals are routed to it via the Limited
Alarm and Discrete Alarm functions. A discrete output can be assigned one of the
following usage modes:

• DO

• Common alarm

• Stream

• Analyzer01

The usage mode can be changed with MON2020.

Switch

Indicates the discrete input’s operational mode. Options are: Auto, On, and Off. This field
can be changed by the user.

Current Value

Indicates the current state of the discrete output. Options are On and Off.
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The Analog Inputs screen

Analog Inputs screenFigure 4-11:   

Label

The name of the analog input as set in MON2020.

Switch

An analog input has two operational modes:

• Setting the switch to Variable means that the analog input will be set automatically,
based on the signal it receives.

• Setting the switch to Fixed means that the analog input will be set to the value that
you enter in the Fixed Value field.

This field can be changed with MON2020.

Current Value

Displays the current value of the analog input signal.

Fixed Value

If the analog input is set to Fixed, then analog input signal will be set the value that you
enter into this field. This field can be changed with MON2020.

Zero Scale

The minimum analog input signal value. This field can be changed with MON2020.

Full Scale

The maximum analog input signal value. This field can be changed with MON2020.

mA

Displays the amount of current being received, in milliamperes.
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The Analog Output screens

Analog Output 1 screenFigure 4-12:   

Analog Output 2 screenFigure 4-13:   

Label

The name of the analog output as set in MON2020.

Switch

An analog output has two operational modes:

• Setting the switch to Variable means that the analog output will be proportional to
the variable displayed in the Variables field.

• Setting the switch to Fixed means that the analog output will be set to the value
that is entered in the appropriate Fixed Value field.

This field can be changed with MON2020.

Variable

Displays the system variable to which the analog output is associated. This variable can be
changed with MON2020.
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Current Value

Displays the current scaled value of the analog output signal.

Fixed Value

If the analog output is set to Fixed, then analog output signal will be set the value that you
enter into this field. This field can be changed by the user.

Zero Scale

The minimum analog output signal value.

Full Scale

The maximum analog output signal value.

mA

Displays the amount of current being produced in milliamperes.

4.3.3 The Application menu

The System screen

Analyzer Name

Displays the GC name that appears in the Status Bar on the main window when MON2020
is connected to the GC.

System Description

Displays information that further identifies the currently connected system.

Firmware Version

Revision level of firmware of the GC.

GC Serial Number

Serial number of the GC.

Company Name

The name of the company that owns the GC.

GC Location

The physical location of the GC.

Maintenance Mode

Switches the GC to maintenance mode and triggers an alarm that the GC is down for
maintenance. This option can be switched on or off by the user.

Enable Energy Value Check
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At the end of a calibration, if this feature is enabled, the GC will calculate the Energy Value
and compare it against the value entered on the Cal Gas Cert CV screen. If the values
diverge significantly, the Calibration Energy Value Check Fail alarm will be triggered.

Std Comp Table Version

Indicates which version of the GPA’s standard component table is being used.

Default Stream Sequence

Displays the default sequence to be used by the GC during auto-sequencing.

The Component Data Table screen

Component

Displays the list of available components for the selected stream.

Ret Time

A component’s retention time, which is the time, in seconds, when the apex of the
component's peak is expected to appear.

Resp Fact

A component’s response factor is equal to the value of the component's peak divided by
the component's concentration value.

Calib Conc

The concentration amount, in mole percent, of the component that is present in the
calibration gas.

Uncert %

The maximum acceptable percent of deviation between the new sample concentration
value for the specified component and its calibration concentration value.

The Timed Events Table screen

Event Type

Displays the type of event that occurred.

Valve/Det

The ID number or name of the valve or detector that was affected by the event.

Value

The value depends on the event that is displayed the Event Type column:

• Slope Sensitivity and Peak Width: The number of points to be used.

• Single Baseline: Off, End, Bgn.

• All other events: On or Off.
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Time (s)

Indicates at what time, in seconds, the event will occur during the analysis.

The Streams screen

Label

The name of the stream.

Usage

The type of stream. There are four types: Analy (Analysis), Cal (Calibration), Validate
(Validation), and Unused.

Tot

The number of runs to make for each calibration or validation.

Avg

The number of most-recent calibration or validation runs to use in the average calculation;
for instance, if five calibration runs are performed and Avg is set to 3, then the last three
runs of the five will be used to average the calibration results.

Date/Time

The time at which the first automatic calibration or validation should be performed.

The Status Display screen

Description

The GC parameter that is being monitored. This can be changed with MON2020’s LOI
Status Variables screen.

Value

The GC parameter’s current value.

The Communications screen

Label

The name of the port. This can be changed using the MON2020 configuration software.

Modbus ID

Identification number of the Modbus device used by a host device to communicate with
the GC.

Baud Rate

The baud rate setting. Can be set to one of the following:
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• 1200

• 2400

• 9600

• 19200

• 38400

• 57600

Data Bits

The number of data bits. For RTU communication this is typically set to 8 bits, and for ASCII
mode this is typically set to 7 bits.

Stop Bits

The number of stop bits. This can only be set to 1 in the 370XA.

Parity

The parity check method. For RTU mode, this should be set to NONE. For ASCII mode, this
can be set to EVEN or ODD.

MAP File

The name of the Modbus MAP file being used by the port. The SIM_2251 modbus map is
the same registers as the legacy Model 500/2350A C6+ application that is commonly pre-
configured in custody transfer flow computers and RTU systems and uses the “Daniel”
modbus message format.

The “default Map” is a fully configurable modbus map that uses the MODICON message
format.

Both modbus maps can be modified using the MON2020 software. For details on
modifying the modbus maps, refer to the MON2020 manual.

Port

The type of physical message protocol to be used for the port. Each port can be set to
RS-232 or RS-485 mode independently.

Note
The port will automatically communicate in ASCII or RTU mode, depending on the message format
received from the host device.

TCP/IP Settings

Ethernet 1 IP Address

IP address to use to connect to the GC's RJ45 Ethernet port.

Ethernet 1 Mask

Subnet mask for the Eth1 IP address.
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Ethernet 1 Gateway

Default gateway address for the Eth1 IP address.

Ethernet 1 DHCP

Indicates whether or not the RJ45 Ethernet port’s DHCP feature is enabled. The DHCP
enable switch is located on the back plane at SW1.

Ethernet 2 IP Address

IP address to use to connect to the GC's wired Ethernet port.

Ethernet 2 Mask

Subnet mask for the Eth2 IP address.

Ethernet 2 Gateway

Default gateway address for the Eth2 IP address.

4.3.4 The Logs menu

The Alarm Log screen

User Name

User name of the person who is logged in to the gas chromatograph.

Date/Time

Indicates the date and time when the alarm condition began.

State

Indicates whether the alarm is active (SET) or inactive (CLR).

Alarm Msg

Describes the alarm condition.

The Event Log screen

User Name

User name of the person who made the change.

Date/Time

Indicates the date and time when the event occurred.

Event Msg

Displays a description of the event.
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The Maintenance Log screen

User ID

User name of the person who made the log entry.

Date/Time

The date and time that the log entry was created.

Message

Describes the nature of the maintenance activity that was performed. You can edit this
field.

Note
To add an entry to the log, press 1 on the keypad.

The Add a New Maintenance Log screen

This screen can be accessed from the Maintenance Log screen.

1. Use the up or down arrow keys to select the appropriate maintenance task from the
drop-down list.

2.

Press  to add the log message to the Maintenance Log screen. The
entry and its creation date will appear at the top of the log.

4.4 The GC Control menu

4.4.1 The Auto Sequence screen
Select the Purge stream for 60 seconds check box if you want to allow sample gas to flow
through the sample loop for 60 seconds prior to beginning the first analysis.

To start the auto sequence process, press  on the keypad.

4.4.2 The Single Stream screen
Select the Purge stream for 60 seconds check box if you want to allow sample gas to flow
through the sample loop for 60 seconds prior to beginning the first analysis.

Select the Continuous operation check box if you want to allow for the repeated analysis
of the selected stream.
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To start a single stream analysis, select a stream and then  on the keypad.

4.4.3 The Halt screen
You must be logged in at least at the Regular user level to access this screen. If you are not
already logged in, the Login screen will display.

To halt an analysis, press  on the keypad.

4.4.4 The Calibration screen
You must be logged in at least at the Regular user level to access this screen. If you are not
already logged in, the Login screen will display.

There are two types of calibration:

• Select Normal to perform a manual calibration in which the component data table
for the selected stream will be updated with calibration data unless the data is
outside the acceptable deviations that are listed in the component data table.

• Select Forced to perform a manual calibration in which the component data table
for the selected stream will be updated with calibration data even if that data is
outside the acceptable deviations that are listed in the component data table.

Select the Purge stream for 60 seconds check box if you want to allow sample gas to flow
through the sample loop for 60 seconds prior to beginning the first analysis.

To start a calibration, select a stream and then press  on the keypad.

4.4.5 The Validation screen
You must be logged in at least at the Regular user level to access this screen. If you are not
already logged in, the Login screen will display.

Select the Purge stream for 60 seconds check box if you want to allow sample gas to flow
through the sample loop for 60 seconds prior to beginning the first analysis.

To start a validation, select a stream and then press  on the keypad.

4.4.6 The Auto Valve Timing screen
You must be logged in at least at the Regular user level to access this screen. If you are not
already logged in, the Login screen will display.

This automatic procedure, which takes up to one hour to complete, includes the following
sequence of tasks:

• Sets the timing for each valve.

• Matches all the component peaks.
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• Adjusts the timed events based on peak integration times.

• Runs a calibration.

• Checks the range and order of response factors.

• Adjusts the retention time deviations to avoid peak overlapping.

Select the Purge stream for 60 seconds check box if you want to allow sample gas to flow
through the sample loop for 60 seconds prior to beginning the first analysis.

To start the process, select a stream and then press  on the keypad.

4.5 The Tools menu

4.5.1 The Screen Control screen
Use the up or down arrow keys to select a brightness level from the list box and then press

 on the keypad.

4.5.2 The Set GC Time screen
You must be logged in at least at the Regular user level to access this screen. If you are not
already logged in, the Login screen will display.

To change the date or time:

1.
Press  to activate the MM text box.

2. Enter the appropriate number for the current month.

3.
Press .

4. Move to the next text box.

5. Repeat the first three steps.

Daylight savings time is the practice of temporarily advancing clocks so that afternoons
have more daylight and mornings have less. Typically clocks are adjusted forward one hour
near the start of spring and are adjusted backward in autumn. Since the use of daylight
savings time is not universal, you have the option of enabling or disabling it with the LOI.

To enable or disable daylight savings:

1. Use the down arrow key to select the Enable Day Light Savings check box.

2.

Press  to toggle the check box.
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4.5.3 The Login screen

Note
The word “emerson” is the default User Administrator login for all Rosemount gas chromatographs.
There is no default password.

To log in to the gas chromatograph:

1.

Press  to activate the User drop-down box.

2. Use the arrow keys to highlight your user name.

3.

Press  to deactivate the User drop-down box.

4. Use the down arrow key to move to the Pin text box.

5. Use the alphanumeric keypad to enter your password into the text box.

Note
To enter a letter into an alphanumeric field, press the appropriate key to cycle through its
options until the desired letter appears. For example, to enter an “H”, you must press the
4GHI key three times.

6.
Press .

4.6 Advanced configuration and operation topics

4.6.1 Validation
The 370XA can be configured to validate an analysis of the calibration standard (or another
stream) to ensure that the analysis is within specified limits. The validation can be
configured for any of the streams, including the calibration stream (default). The
validation can be configured to run automatically at a set time and frequency, or it can be
initiated manually.

In previous generations of gas chromatographs, a daily calibration was run to verify the
correct operation and to account for changes in measurement on a daily basis. A
calibration run is typically configured to run for 3 analysis cycles of the calibration gas and
will change the response factors.
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The main advantage of the validation is to confirm the analysis is within specifications
without changing the calibration factors.

Prepare for a validation

Before starting a validation run you must configure the stream that you intend to use as
the validation stream.

The 370XA allows you to assign virtual streams to any of its stream selection solenoids. By
default, the fifth stream is configured as the validation stream.

1. Start MON2020 and select Streams on the Application menu.

The Streams window opens.

2. Enter the Total Runs and Avg Runs for the validation cycle.

The total runs is the number of analysis cycles that will be run in total. The average
runs is the number of runs that will be used to average and then validate the data.
For example, if the total runs is 3, and the average runs is 2, the validation cycle will
analyze the validation streams for three cycles, and the last two cycles will be used
to average the results and validate the measured values. By default, both are
configured for one run only.

3. Select the physical stream in the Stream Valve column that will be used for the
validation gas.

• If the validation is to be done against the calibration gas, select Calibration from
the Stream Valve drop-down list.

• If the validation is to be done with a gas other than the calibration gas on a
single-stream GC, select Calibration from the Stream Valve drop-down list and
install a manual three-way valve before the calibration inlet on the sample
conditioning system.

• If the validation is to be done with gas other than the calibration gas on one of
the streams of a multi-stream GC, select the appropriate stream valve from the
Stream Valve drop-down list.

4. If you are using the calibration gas or if the validation gas is permanently installed
and you want to run a validation on a schedule, do the following:

a. Select the check box in the appropriate Auto column.

b. Select the Start Time for the first validation.

c. Enter the Interval, in hours, between validation runs.

Note
If you are configuring an auto-validation and an auto-calibration, schedule the validation run
to occur at least 30 minutes before the calibration run to provide a validation of the
measurement just before the calibration cycle re-calculates the response factors.

5. Click OK to save the data and close the Streams window.
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6. Select Validation Data on the Application menu. The Validation Data window
opens.

Note
The Validation Data command will not be available on the Application menu unless at least
one stream is assigned to Validate in the Usage column on the Streams window.

7. Select the Variables to be validated and enter the Nominal Value and the Percent
Deviation for each.

Note
When entering variables, if you want to enter the next component from the component data
table based on the previously entered component, click C+Copy (F8).

Run a validation

Once the validation settings have been configured, the validation cycle will begin at the
scheduled time if the GC is in Auto mode.

The validation cycle can also be started by selecting Validation on the Control menu.
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Note
You can generate a Validation Report at any time by choosing Main Menu > View > Report Display from
the LOI or Logs/Reports > Report Display from MON2020.

4.6.2 Change the calibration gas
Changing the calibration gas is a very critical procedure that can significantly affect the
accuracy of the gas chromatograph if not performed correctly. Before using a new
calibration gas blend for calibrating the gas chromatograph, the composition stated on
the certificate must be verified by using the 370XA to analyze the new calibration gas.

1. Go to the Tools menu and select Change Cal Cylinder. The Calibration Cylinder
Replacement Assistant screen displays.

Note
You may be required to log in first. The default login values are:
User: emerson

Password: [blank]

2. Follow the software assistant’s prompts.

Note
Step 6 of 10: The calibration gas concentrations can be obtained from the bottle certificate.
The screen will auto calculate the Methane value if the Auto Calculate Methane check box is
selected. If the calibration gas’ certificate displays a Methane value, compare the value to the
screen’s Methane value. If the values do not match, confirm that you have entered the other
values correctly.

Note
Step 7 of 10: If the certificate states an uncertainty percentage for each component, enter
them here. If the certificate does not show the uncertainty percentages, then the default
value of 2% should be used. The uncertainty values can be used to confirm that the analysis of
the calibration gas matches the certificate values before the standard is used to calibrate the
GC.

Note
Step 8 of 10: If the certificate includes the energy content, enter it on this screen. If the
certificate does not include an energy content, use the calculated energy content shown.

After you have followed all of the assistant’s prompts, it will analyze the calibration gas and
repeat the analysis until the nitrogen value repeats within the uncertainty value entered on
a previous screen. Because air is 78% nitrogen and the calibration gas contains significantly
less nitrogen than this, the analyzed nitrogen content should typically start high and then
decrease as the system is purged with the new gas. The screen displays the nitrogen value
for each run on the table to the left of the chromatogram. Once the nitrogen value has
stabilized, the last analysis will be compared to the entered certificate values to ensure
that the GC is analyzing accurately.
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4.6.3 Auto valve timing
The analytical valves in the oven are switched on or off during the analysis cycle to change
the analytical flow path to separate certain components through particular columns. For
the C6+ analysis, column one separates the hexane and heavier components (C6+) from
the pentane and lighter components, column two separates the propane to pentane
components, and column three separates the nitrogen, methane, carbon dioxide, and the
ethane. The timing of the valve switching is critical to the accurate performance of the
analysis.

Over time, the resistance to flow and the performance of the columns will change
(typically, the retention times get slower) resulting in the switching of the valves "cutting"
into some of the component, rather than switching between the peaks as they elute from
a column.

The timing of the valve switching to separate between two components
eluting from a column. The example on the left shows the ideal time
between the two peaks. The example on the right shows the valve
timing is too early, and will result in the exclusion of some of the
normal-pentane.

Figure 4-14:   

Traditionally, highly trained gas chromatograph experts would manually adjust the valve
timing and tune the timing of the integration events occasionally to account for the small
changes in retention times and measurement issues.

Auto valve timing (AVT) automates this process so that even an inexperienced user can
initiate an adjustment of the valve timing, letting the GC’s internal algorithm adjust and
optimize the valve timing automatically.

To initiate AVT, go to the Control menu from the LOI or MON2020 and select Auto Valve
Timing.

The AVT will use the calibration stream to make adjustments. The configuration selection
provides options for the starting point for the adjustments:

• Use module default - The AVT algorithm will start using the factory default values
loaded into the module when the module was originally built. Use this option when
maintenance has been performed on the module, for example, the analysis valve
diaphragms have been overhauled, and the retention times have significantly
changed from the last calibration.

• Use current - The AVT algorithm will start using the valve timing and integration
settings currently in the module.
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4.6.4 Warm-start mode
When power is reinstated after being lost while the GC is in auto-analysis mode, the GC will
enter warm-start mode and try to go back on line. In warm-start mode, the GC monitors
the oven temperature until it is stabilized at the set point, runs calibration gas, and checks
that all of the components are detected correctly. Once the calibration gas has been
analyzed correctly, the GC will re-enter auto-analysis mode.

If the warm-start mode fails to complete within 2 hours, a warm start failure alarm will be
triggered, and the GC will go into Idle mode.

4.6.5 Maintenance mode
Maintenance mode allows you to work on the GC while alerting the supervisory system that
the current analysis may not be valid, and should not be used. Maintenance mode triggers
a system alarm that can be read as a Modbus Register (bit 0 on Register 3046 in the
SIM_2251 Modbus map), and on the Common Alarm digital output.

To enable maintenance mode, select its check box on the System window from the LOI or
MON2020.

When maintenance mode is active, the analysis in the Modbus registers will still be
updated so that communication to the supervisory system can be tested; however, the
analysis results during maintenance mode will not be included in the averages calculated
by the GC.

4.6.6 Conserve calibration gas
To save calibration gas, the 370XA has a unique feature called Cal-Gas Saver that reduces
calibration gas usage significantly. During normal operations, the next stream will start to
be purged through the sample loop from when the sample shut-off valve that is operated
by the back-flush valve timing, at around 25 seconds, is opened, through to the start of the
next analysis. This ensures that the sample lines and the sample loop are completely
purged of the previous stream and the sample loop is full of the next sample to be
analyzed.

Cal-Gas saverFigure 4-15:   
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A calibration cycle involves running multiple analysis cycles of the calibration gas. Because
there are multiple runs of the same gas, there is no need to purge the sample lines leading
up to the sample loop after the first analysis run. To conserve the amount of calibration gas
used by the 370XA while still maintaining calibration accuracy, the calibration gas saver
feature turns off the calibration gas stream for a longer period during the calibration gas
analysis cycles to dramatically reduce the amount of calibration gas consumed.

The Valve Events table showing the Cal Gas Save events turned on at 20
seconds and turned off at 200 seconds.

Figure 4-16:   

By default, the calibration gas saver is switched on at 20 seconds and turned off at 200
seconds, but these values can be changed.

1. Start MON2020 and select Timed Events on the Application menu. The Time
Events window opens.

2. Locate the first Cal Gas Save event on the Valve Events table. This event switches
on the Cal-Gas Saver feature.

3. Enter a new start time in the appropriate Time field.

4. Locate the second Cal Gas Save event on the Valve Events table. This event
switches the Cal-Gas Saver feature off.

5. Enter a new end time in the appropriate Time field.

6. Click OK to save the changes and close the window.
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4.6.7 New Module Software Assistant
When you install a new analytical module on the 370XA and turn on the power, the GC will
recognize that a new module has been installed and will start the New Module software
assistant, which will heat up the oven, run carrier gas through the analytical paths, and
cycle the analytical valves to rapidly purge the system.

New Module software assistantFigure 4-17:   

Note
The New Module software assistant can also be initiated from the LOI or MON2020 by selecting
Module Validation on the Tools menu.

Note
Changing the CPU board will also start the New Module software assistant because of the mismatch
between the CPU board and the analytical module. In this case, you should stop the assistant by

pressing .
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While the GC is heating up to temperature, the LOI will show the Calibration Gas Info
composition screen so that you can confirm that the module’s calibration gas values
match the concentrations and the uncertainty on the calibration gas bottle certificate.

Calibration concentration informationFigure 4-18:   

When the oven temperature has stabilized, the software assistant will automatically run
calibration gas and validate the module. The validation will run three analysis cycles of
calibration gas and confirm that the analysis is within the pre-configured specifications. If
the analysis is within the specifications, a calibration cycle will then be run. If the analysis is
not within the specifications, a Module Validation Fail alarm will be raised, and the unit will
go into Idle mode.

After the calibration cycle is completed, the 370XA will then go into Auto mode and begin
analyzing the stream gas.
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5 Recommended Spare Parts

The 370XA gas chromatograph was designed for easy maintenance in the field with a
unique “maintainable module.” To minimize downtime in the field, you can replace the
entire analytical module with a spare one. Additionally, the module can be repaired on a
component level by a trained technician either in the field, at a central maintenance
location, or by the Rosemount Analytical Lifecycle services team.

This list of spares includes an entire analytical module, plus the components typically
required to maintain the module in typical natural gas service and the sample handling
components that may need to be replaced on a regular basis.

370XA spare partsTable 5-1:   

Part Number Qty Description

7A00136G02 1 Replacement Maintainable Module Kit, C6+, Multi-Stream (3 Sample +
Cal)

7A00137G01 3 370XA 6-port Valve Diaphragm Repair Kit

7A00140G01 1 Sample Shut-Off Valve Repair Kit

7C00020-001 1 Valve, Solenoid, 4-Way, SMC

7C00023-001 1 Valve, Solenoid, 2-Way Isolation, Asco

7C00024-001 1 Valve, Proportional, Solenoid, Asco

2-4-5000-938 1 Membrane Kit, Genie® Model 120 Filter/Bypass/LSO

2-4-5000-113 1 Filter Element 2 micron,Swagelok SS-2F-K4-2

7A00022G01 1 ASSY, Carrier Dryer, Compact, Sample System, 370XA
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6 Replacing the maintainable module
Topics covered in this chapter:

• Remove the maintainable module

• Install a maintainable module

6.1 Remove the maintainable module
Tools required:

• 2 mm hex or Allen wrench

• 4 mm hex or Allen wrench

1. Remove power from the GC.

2. Turn off the sample gas(es) at the isolation valve(s) in the external sample system
that is closest to the GC

3. Turn off the calibration gas at the isolation valve closest to the GC.

4. Turn off the carrier and actuation gases at the isolation valve closest to the GC.

5. Use a 2 mm hex wrench to loosen the dome locking screw (1). It is located on the
left side of the GC above the gas lines.

Dome locking screwFigure 6-1:   
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6. Unscrew the dome to remove it.

If the dome is too tight, insert two screwdrivers or similar tools into the grooves (1)
at the top rim of the dome to provide additional leverage when twisting the dome.

Dome removalFigure 6-2:   

CAUTION!
The grooves are designed to aid you in loosening the dome. Do not attempt to use them
to tighten the dome.

7. Remove the insulation cap.

WARNING!
The oven will be approximately 176 °F (80 °C) and hot to the touch.

8. Loosen the four 4 mm (5/32-inch) hex screws holding the module to the base.
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You may hear the release of some trapped carrier and sample gases. If the release is
continuous, confirm that the sample, calibration, carrier, and actuation gases are
isolated.

9. Remove the four hex screws (1).

10. Remove the analytical module.

a. Grip the module base and carefully lift it off its housing.

b. While continuing to hold the module, disconnect the three connectors.

11. Discard the ten o-rings on the spring-action feed-through. New o-rings should be
installed when a new or overhauled module is installed.

6.2 Install a maintainable module

Parts required An analytical module and a pack of ten o-rings.

Tools required A 5 mm hex or allen wrench.

The power should remain off, the various gases should continue to be isolated external to
the GC, and the dome should remain off.

1. Inspect the spring-loaded feed-through to ensure all the o-rings have been
removed.
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2. Install the new o-rings into the spring-loaded feed-through.

Note
To ensure the proper and reliable operation of the GC, always use new o-rings supplied as a
part. O-rings should never be re-used or sourced from third-party suppliers.

3. Inspect the under side of the new analytical module to ensure that there are no o-
rings stuck to the module base.

4. Connect the solenoid electrical connector to the male connector leading to the
solenoids.

5. Connect the male 18-pin signal connector to the connector on the IMB circuit board.

6. Connect the two-pin heater connectors.

7. Align the groove on the module base to the front of the GC and lower the module
down onto the guide pins on the spring-loaded feed-through.

8. Insert the four module mounting screws and hand tighten.

9. To ensure the module is installed square, tighten the mounting screws in a cross-
pattern as shown below.
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10. Place the insulation cap over the heater cap.

11. Open the actuation gas isolation valve.

Note
When opening the valves for the various gases to the GC, listen for leaks. If a leak is heard,
isolate all of the gases and check that the o-rings in the spring-loaded feed-through are
installed correctly.

12. Set the carrier gas supply pressure to 90 psig (6.2 BarG) and open the isolation valve
on the carrier gas supply to the GC.

13. Set the calibration gas pressure to 15 psig (1 BarG) and open the isolation valve on
the calibration gas supply to the GC.

14. Set the sample gas(es) pressure to 15 psig (1 BarG) and open the isolation valve to
the GC.

15. Screw the dome over the analytical module and hand tighten.

CAUTION!
The hazardous area flame-path seal is a combination of the number of threads, and the
o-ring seal and does not rely on the dome being tightened excessively; therefore, do not
over tighten the dome because this could result in difficulty when removing the dome at
a later stage. Hand-tightening the dome to the end of the thread is all that is required.

16. Tighten the dome locking screw.

17. Power up the GC.

After the firmware starts running, the GC will check the serial number of the new module
to determine if it matches the serial number of the module that was in place when the GC
was shut down. If it does not, the GC will start the new module software assistant. If the
serial numbers do match, the GC will warm up and stay in idle mode.
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7 Overhauling the analytical module
Topics covered in this chapter:

• Replace a stream selection solenoid

• Replace an analytical valve solenoid

• Overhaul the analytical valve

• Overhaul the sample shut-off valve

• Replace the carrier pressure control valve

• Replace the carrier gas pressure sensor

• Replace the detectors

• Replace the chromatograph columns

• Replace the o-rings in a tubing connector

Maintainable module - exploded viewFigure 7-1:   
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The following table lists the most common problems along with their solutions:

Troubleshooting the Maintainable moduleTable 7-1:   

Problem Section

A single stream cannot be selected for analysis
but other streams can, or one stream appears to
be contaminating other streams.

Section 7.1.

An analytical valve is not actuating correctly. Section 7.2.

The retention times for the components have
shifted later in the analysis run, or valve switch-
ing noise is excessive.

Section 7.3. When overhauling the analysis
valves, it is good practice to overhaul the sam-
ple shut-off valve as well.

The un-normalized total is erratic and fluctuates
with changes in the sample pressure.

Section 7.4

The module is contaminated by a large amount
of liquids, or the response of the detectors has
dramatically reduced.

Section 7.7

The analyzer has been exposed to significant
contamination that resulted in a reduction in
the separation of the components.

Section 7.8

If the carrier gas pressure is not being controlled
or there is excessive drift on the baseline, the
carrier gas pressure control valve should be re-
placed.

It may be difficult to diagnose whether the issue
is with the pressure control valve or the pressure
sensor, so it is recommended to replace both if
there is a problem with the carrier gas pressure
control.
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7.1 Replace a stream selection solenoid

Parts required A replacement stream selection solenoid
(#7C00023-001).

Tools required A 2.5 mm hex or allen wrench.

This procedure assumes that you have removed the analytical module from the GC. If this
is not the case, see Section 6.1, Step 10.

1. Turn the module upside down so that it is resting on its heater cap.

The stream selection solenoids—the sample stream (1) and the calibration stream
(2)—will be exposed.

2. Identify the solenoid(s) to be replaced.

3. Remove the electrical connector from the solenoid:

a. Squeeze the top of the connector.

b. Press the retention lever in.

c. Carefully pull the connector out.

4. Unscrew the two 2.5 mm hex screws.

5. Remove the solenoid and the seal.

6. Inspect the new solenoid's seal (1) and ensure that it is firmly seated in the base of
the solenoid.
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7. Place the solenoid onto the module base with the connector located closest to the
module edge.

8. Hand-tighten the two hex screws to secure the solenoid.

9. Reconnect the connector to the solenoid, ensuring the retention clip engages. The
connectors are labeled according to the following table:

Label Solenoid

SV1 Calibration solenoid

SV2 Stream 1

SV3 Stream 2

SV4 Stream 3

10. Reinstall the module on the 370XA base and analyze gas through each stream to
confirm the repair has been successful.

7.2 Replace an analytical valve solenoid
This procedure assumes that you have removed the analytical module from the GC.

1. Turn the module upside down so that it is resting on its heater cap.

The analytical valve solenoids (1) will be exposed.

2. Identify the solenoid(s) to be replaced.

3. Remove the electrical connector from the solenoid:

a. Squeeze the top of the connector.

b. Press the retention lever in.

c. Carefully pulling out.

4. Use the Phillips-head screw-driver to unscrew the two solenoid retaining screws.

5. Remove the solenoid seal.

6. Inspect the new solenoid's seal and ensure that it is firmly seated in the base of the
solenoid.

7. Use the mounting screws to hold the new seal in place.
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8. Place the new solenoid on the manifold block and hand-tighten the two mounting
screws.

9. Reconnect the connector to the solenoid, ensuring the retention clip engages. The
connectors are labeled according to the following table:

Valve label Manifold label Description

AV1 AV1 Sample valve

AV2 AV2 Back-flush valve

AV3 AV3 Dual column valve

10. Reinstall the module on the 370XA and run an analysis to confirm correct operation.

7.3 Overhaul the analytical valve

1. Hex bolt 6. Lower piston plate 11. Primary diaphragm

2. Flat washer 7. Upper actuator diaphragms 12. Thin guide pin

3. Actuation cap 8. Short pistons 13. O-rings (2)

4. Lower actuator diaphragms 9. Upper piston plate 14. Thick guide pin
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5. Long pistons 10. Cushion diaphragm 15. Actuation base plate

Parts required A valve overhaul kit for each valve to be serv-
iced.

Tools required • A vise with aluminum soft-jaws or some oth-
er protection to avoid marking the analytical
valves with the vice jaws.

• A 2.5mm hex or allen wrench.
• An 11mm (7/16in) socket and a socket

wrench.
• A torque wrench.
• A no-residue, evaporating electrical contact

cleaner.

To maximize the time between repairs to the module, it is recommended to overhaul all
three analytical valves and the sample shut-off valve at one time, rather than repairing only
a single valve when it is suspect.

Perform this procedure in a clean environment. When removing the components from the
valve, place them onto a clean work surface to avoid contaminating the valve
components.

This procedure assumes that you have removed the analytical module from the GC.

1. Remove the heater cap from the module.

2. Remove the three hex screws holding down the analytical valve.
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3. Remove the valve by carefully lifting it until it clears the locating pins (1) on the
module base.
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4. Remove the eight o-rings (1) from the base of the module and dispose of them.

5. Place the analytical valve in the vice, clamping onto the flat edges of the valve's
base.

6. Use the socket wrench and socket to remove the valve's center hex bolt (1).

7. Remove the flat washer (1).

8. Remove the actuation cap plate (1).
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9. Remove and dispose of the two upper actuation diaphragms (1).

10. Remove the lower piston plate (1) and the three long pistons (2) as one assembly.

11. Remove the two upper actuation diaphragms (1) and discard them.

12. Remove the upper piston plate (1) and the three short pistons (2) as one assembly.
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13. Remove and discard the cushioning diaphragm (1), the primary diaphragm (2), and
the two o-rings (3).

14. Remove the two guide pins (1).

15. Use a clean and lint-free cloth to remove any residue clinging to the upper sealing
surface of the base plate.

16. Spray the electrical contact cleaner through each of the ports of the base plate,
ensuring a clean, unobstructed flow through each port.

17. Clean the upper sealing surface of the base plate with the electrical contact cleaner.

18. Blow down the base plate with clean and dry air.

19. Return the two guide pins to the valve’s base.
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20. Place an o-ring (1) over each actuation gas port hole (2). The holes are located on
the actuation base plate.

21. Place the primary diaphragm (1), which has four holes, so that the holes in the
diaphragm align with the two guide pins and the two actuation gas ports with the o-
rings.

22. Place the cushioning diaphragm (1) onto the primary diaphragm so that the
diaphragm's holes align with the holes of the primary diaphragm.

23. Place the upper actuation plate (1) over the actuation base plate with the upper
actuation plate's short pistons (2) pointing down. The pistons should be flat with the
top of the piston plate.
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24. Place the two upper actuation diaphragms over the upper actuation plate so that
the diaphragms' holes align with the holes in the upper actuation plate.

25. Place the lower actuation plate (1) onto the upper actuation plate with the lower
actuation plate's long pistons (2) pointing down. The pistons should be flat with the
top of the piston plate.

26. Place the two lower actuation diaphragms (1) over the lower actuation plate so that
the diaphragms' holes align with the holes in the lower actuation plate.

27. Place the actuation cap (1) over the lower actuation plate.
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28. Insert the hex bolt (1) with its flat washer (2) into the assembled valve's center hole
and hand-tighten.

Note
The washer is slightly curved and should be placed so that it curves up to the center.

29. Use a torque wrench and 11 mm socket to tighten the hex bolt to 20 ft/lb (2.76
kg/m).

30. Set the new o-rings into the actuation valve ports on the module base plate.

31. Insert the three socket screws into the holes of the analytical valve base plate.

32. Align the thick and thin locating pins in the base plate with the locating holes in the
analysis valve and install the analysis valve onto the base plate.

33. Tighten the socket screws with the 2.5 mm hex or allen wrench.
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7.4 Overhaul the sample shut-off valve

Parts required A sample shut-off valve overhaul kit
(#7A00TBA).

Tools required • A 2.5 mm hex or allen wrench.
• A no-residue, evaporating electrical contact

cleaner.

Perform this procedure in a clean environment. When removing the components from the
valve, place them onto a clean work surface to avoid contaminating the valve internals.

This procedure assumes that you have removed the analytical module from the GC.

1. Remove the heater cap from the module.

2. Use the 2.5 mm hex or allen wrench to remove the two mounting screws (2) on the
sample shut-off (SSO) valve (1).

3. Remove the two parts of the SSO valve (1) from the module and the locating pin (2).
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4. Discard the three o-rings (1) from the module base.

5. Remove the locating pin and separate the upper and lower plates of the SSO valve.

6. Remove and discard the small o-ring (3), the large o-ring (2), and the diaphragm (4)
from the interior of the SSO valve (1).
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7. Use the electrical contact cleaner to cleanse the sealing surface of the lower plate (1)
and the two sample flow holes (2) through the lower plate.

8. Blow down the lower plate with clean and dry air.

9. Set one of the small o-rings from the kit into the actuation gas path recess (2) on the
lower plate (1).

10. Turn the upper plate (1) upside down and set the large o-ring (3) from the kit into
the recess (2) of the upper plate.
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11. Place the remaining three small o-rings from the kit on the SSO valve's sample and
actuation gas paths (1) on the module base.

12. Insert the locating pin into the module base.

13. Turn the lower actuating plate so that its o-ring is face up and then slide the lower
actuating plate over the locating pin and into place on the module base.

14. Place the SSO diaphragm from the kit onto the lower plate and align the
diaphragm's holes with the holes in the lower plate.

15. Slide the upper plate over the locating pin and align the upper plate's mounting
holes with the holes in the lower plate.

16. Insert the two mounting bolts and tighten with the 2.5 mm hex or allen wrench.
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7.5 Replace the carrier pressure control valve

Parts required • A carrier pressure control valve kit
(#7C00024-001)

• Two sets of o-ring kits (#7C00030-006)

Tools required A 2.5mm hex or allen wrench.

1. Rest the module upside down on the heater cap.

2. Unclip the electrical connector leading to the carrier pressure control valve (1).

3. Use a 2.5 mm hex wrench to remove the two carrier pressure control valve
mounting bolts (2).

4. Carefully lift off the carrier pressure control valve.

5. Remove and dispose of the two o-rings in the module base.
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6. Install the new o-rings into the module base.

7. Use the 2.5 mm hex wrench to screw the new carrier pressure control valve onto the
module. Do not over-tighten.

8. Re-connect the electrical connector and ensure the retention clip is engaged.

7.6 Replace the carrier gas pressure sensor

Parts required A carrier gas pressure sensor kit
(#7A00053G01).

Tools required • A 2.5 mm hex or allen wrench
• An 8 mm wrench

1. Rest the module upside down on the heater cap.

2. Disconnect the carrier gas pressure sensor’s (1) electrical connectors (3) from the
Intelligent Module Board (2).
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3. Use the 2.5 mm hex wrench to remove the Intelligent Module Board (IMB).

4. Use the 8 mm wrench (or small adjustable wrench) to gently unscrew the pressure
sensor from the module base.

5. Check that the o-ring was removed with the sensor. If not, remove and dispose of
the o-Ring.

6. Carefully hand-tighten the new sensor into the module base.

7. Use the 8 mm wrench (or small adjustable wrench) to carefully tighten the sensor by
a half-turn. Do not over-tighten.

8. Use the 2.5 mm hex wrench to reinstall the IMB.

9. Reconnect the electrical connectors into the IMB.

7.7 Replace the detectors

Parts required A detector overhaul kit.

Tools required • A 2.5 mm hex or allen wrench
• A 1 mm hex or allen wrench
• An 8 mm open-ended wrench

Note
The detectors should always be replaced as a pair.

Perform this procedure in a clean environment. When removing the components from the
valve, place them onto a clean work surface to avoid contaminating the valve
components.
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This procedure assumes that you have removed the analytical module from the GC.

1. Remove the heater cap from the module.

2. Disconnect the detector’s electrical connector (2) from the Intelligent Module Board
(1), which is located on the under side of the maintainable module.

3. Remove the large o-ring (1) from around the module base to enable the cables from
the detector assembly to move freely.
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4. Pull the cables up through the middle of the columns so that they will not interfere
with removing the detector assembly.

5. Remove the two TCD block mounting screws (1). Do not remove the two heat-pipe
cover screws (2) because the cover will be used to pull off the detector assembly.

6. Remove the detector assembly by gently pulling up with a small rocking motion on
the heat-pipe bracket.
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Note
One or both of the heat-pipes may stay in the base plate. Do not try to remove them because
you may bend the soft heat-pipes which will reduce their performance.

7. Discard the two o-rings on the detector block.

8. Use the 2.5 mm hex or allen wrench to remove the two heat-pipe cover retaining
screws and then lift off the heat-pipe cover.

9. If the detector assembly still contains any heat-pipes, carefully twist and pull them
out.

CAUTION!
The thermal performance of the heat pipe and the analytical performance of the GC will
be greatly reduced if the heat pipe is damaged or bent excessively.

10. Use the 8 mm open-ended wrench to unscrew the two detectors and then remove
them.

11. Unscrew and remove the detector wires from the detector connector, noting which
detector wire goes into which terminal.

12. Use the 1 mm hex or allen wrench to remove the Teflon seals that are in each of the
detector recesses. Discard the Teflon seals.

13. Use electrical contact cleaner to cleanse the sealing surfaces and the two sample
flow holes that run through the detector assembly.

14. Blow down the detector assembly with clean and dry air, nitrogen, or helium.

15. Insert a new Teflon seal into the bottom of each of the detector recesses. Ensure
that each seal is flat on the sealing edge at the base of the recess.

16. Screw the detectors into the detector assembly. Tighten the screws with the 8 mm
open-ended wrench.

17. Insert the detector wires into their corresponding terminals. You should have noted
this in Step 11.

18. If any heat-pipes were removed from the detector assembly, reinsert them into the
detector block.

19. Place the heat-pipe springs over the heat pipes.

20. Re-install the heat pipe cover and hand-tighten the screws until the base of the
bracket is tight against the detector assembly.

21. Lightly coat the exposed ends of the heat pipes with thermal compound.

22. Press two new o-rings into the detector base, ensuring that they are packed tightly
in the recesses to form tight ovals.

23. Orient the module so that the groove on the base is facing you. Place the detector
assembly onto the detector block with the RTD and cables on the left.

24. If a heat-pipe remained in the base when the detector was removed, reinstall the
spring over the heat pipe as the detector assembly is put into place.

25. Hand tighten the detector's two mounting screws with a 2.5 mm hex or allen
wrench.
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26. Ensure that the heat-pipe cap is moving freely and is at the full extension.

27. Route the cables under the columns and through the cable entry groove on the left
of the module.

28. Re-install the large o-ring around the module's top-plate so that the cables are held
into the cable entry groove.

29. Plug the connector into the IMB board. There should be an audible click when the
clip is engaged.

7.8 Replace the chromatograph columns

Parts required A 370XA C6+ 4-minute column set (#
7A00101G01).

Tools required A 4 mm hex or allen wrench

The chromatograph columns should be replaced as a set. The tubing connectors use a
unique double o-ring sealing arrangement. The bolt on the tubing connectors should only
need to be loosened to facilitate removing the columns, and should not be removed
unless the o-rings are to be replaced.

7.8.1 Installation
1. Use the 4 mm hex or allen wrench to loosen each of the tubing connector bolts by a

½ turn only.

Note
Do not remove the bolt from the tube connector fitting, because the o-rings and spacers will
come out of the fitting.

2. Carefully pull each column end from the tubing connectors.

3. Discard the old columns.

4. Install the new columns:

a. Insert each column into the appropriate connectors according to the markings
on the manifold plate and the tag on the column. See “Column assignments” on
page 6-39 and “Column drawings” on page 6-39 for help matching the column
with the column connectors.

b. Push the tube (A) into the connector (B) until it meets resistance and is fully
inserted into the connector.
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c. When all of the tubing for a single connector is inserted, tighten the connector
bolt (C) with the 4 mm hex or allen wrench.

Note
If the connectors are not tightened correctly, there is the potential for a leak. The tubing
must go through both of the two o-rings. It is important to follow the procedure and
check the fitting before applying gas to the unit.

d. Carefully pull each tube entering the fitting to ensure that it is held by both o-
rings. If a tube is not held by both o-rings, it will pull out easily, and the bolt will
need to be loosened and the procedure repeated until all four tubes are sealed by
the dual o-rings.
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7.8.2 Column assignments

Tubing Connector 1 Tubing Connector 2 Tubing Connector 3 Tubing Connector 4

C2 Column 2 Sph Sample
Pre-Heat
Coil

Sph Sample
Pre-Heat
Coil

SL Sample
Loop

C1 Column 1 Cph Carrier
Pre-Heat
Coil

R Restrictor
Column

SL Sample
Loop

C4 Column 4 C2 Column 2 R Restrictor
Column

C4 Column 4

C1 Column 1 C3 Column 3 C2 Column 2 Cph Carrier
Pre-Heat
Coil

7.8.3 Column drawings
Use the drawings that follow to match the column with the column connectors.

Column 1

Column 2
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Column 3

Column 4
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Sample Pre-Heat Coil (Sph)

Carrier Pre-Heat Coil (Cph)
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Sample Loop (SL)

Restrictor Column (R)
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Completed installation
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7.9 Replace the o-rings in a tubing connector

Parts required 1 packet of replacement o-rings (#
7C00030-006).

Tools required A 4 mm hex or allen wrench

1. Use a 4 mm hex wrench to loosen the tubing connector bolt (A) by a ½-turn.

2. Pull each of the four tubes out of the connector.

3. Remove the tubing connector bolt.

4. Remove the tubing connector (B).

5. Remove and dispose of the four upper o-rings.

6. Remove the four o-ring spacers (C).

7. Remove and dispose of the four lower o-rings. If the o-rings stick inside the base
plate, use a short length of 1/16th stainless tube to work the o-ring out.

8. Place a new o-ring into each of the four tubing holes in the base plate.

9. Insert a new spacer into each of the four holes in the baseplate, firmly pushing them
down until the o-ring from the previous step is seated into the bottom. Check that
the top of each of the spacers is protruding the same distance as the other spacers
to ensure each o-ring is seated flat.

10. Place a new o-ring on top of each of the four spacers, loosely aligning the center
hole of the o-ring with the center hole of the spacer.

11. Place the tube connector over the o-rings and spacers, ensuring the holes in the cap
align with the o-rings and spacers.

12. Screw in the mounting bolt and hand-tighten.

13. Insert the columns into the connector according to Section 7.8.2 and Section 7.8.3.
Each of the columns has tags that identify their application.
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Note
If the connectors are not tightened correctly, there is the potential for a leak. The tubing must
go through both of the two o-rings as shown in Step 1. It is important to follow the procedure
and check the fitting before applying gas to the unit.

14. Push each tube into the fitting so until it stops hard against the base plate.

15. Apply downward pressure onto the four tubes entering the fitting and tighten the
bolt using the 4 mm hex or allen wrench.

16. Carefully pull each tube entering the fitting to ensure that it is held by both o-rings.
If a tube is not held by both o-rings, it will pull out easily, and the bolt will need to be
loosened and the procedure repeated from step 14 until all four tubes are sealed by
the dual o-rings.
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8 Troubleshooting the 370XA
Topics covered in this chapter:

• Alarms

• Flowcharts

8.1 Alarms

Alarm Description and Suggested Actions

Maintenance Mode The maintenance mode is on. The flag in the
Modbus map for maintenance mode is switched
on, and the discrete out for active the Common
Alarm (if configured) will be on. Refer to “Main-
tenance mode” on page 4-38 for more informa-
tion.

Power Failure The 24VDC power supply to the GC failed. Note
that the SET time indicates the time power was
restored to the GC. To determine when the
power was lost, look at the time of the last anal-
ysis before the power fail occurred.

User Calculation Failure An error occurred in one of the User Defined cal-
culations. Check the user calculations for divide
by zero errors or for incorrect references.

Low Battery Voltage The CPU battery voltage is low. As the battery is
soldered onto the board, the CPU board needs
to be returned to the factory to replace the bat-
tery correctly.

Stream Skipped There was an error in stream sequencing that re-
sulted in failure to analyze one of the streams in
the stream sequence. This alarm will occur if a
stream's usage is switched to "Unused" without
removing the stream from the Stream Se-
quence. To correct this start MON2020 and se-
lect Stream Sequence on the Application
menu. Delete the unused stream from the se-
quence.
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Alarm Description and Suggested Actions

GC Idle The analysis mode was switched to GC Idle and
there was no connection to a MON2020 soft-
ware session. If the mode is changed to Idle
while MON2020 is connected, this alarm will not
be generated. If the mode is switched to Idle via
the local operator interface, or the GC is in Idle
mode when a MON2020 software session is dis-
connected, this alarm will be active.

Warm Start Failed The GC has failed to return to analysis mode af-
ter a power failure. If the GC is in Auto Analysis
mode and the power is lost, when power is reap-
plied the unit will heat up and analyze calibra-
tion gas until all of the component peaks are
identified. When all of the peaks are identified
and the analysis is good, the GC will go back into
Auto Analysis mode. However, if the peaks are
not identified within the time period indicated
in the Max Warm Start Delay field on the System
window, the GC will raise the Warm Start Fail
alarm and go into Idle Mode and will not analyze
stream gas.

Heater 1 Out Of Range The Analytical Oven Heater failed to reach the
set-point within 15 minutes or reads higher than
the setpoint. Refer to the Heater Failure trouble-
shooting guide.

Heater 2 Out Of Range For the default configuration of the 370XA, this
is not used. The Switch setting on the Heaters
screen for Heater 2 must be set to Fixed ON and
the Fixed PWM Output set to 0.

Detector 1 Scaling Factor Failure The scaling factor generated for the high and
low gain preamp channel was outside the ac-
ceptable range of values. This is typically caused
by a fault on the analyzer board, which should
be replaced.

Carrier Pressure Low The carrier gas pressure, as measured on the
carrier gas pressure sensor on the analytical
module, is too low. Check the regulated pres-
sure at the bottle is at 90 PSI (6.2 BarG), and
confirm the isolation valves between the bottle
and the 370XA are all open. Refer to for help
with troubleshooting this issue.
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Alarm Description and Suggested Actions

Carrier Pressure Out Of Range The carrier gas pressure, as measured on the
carrier gas pressure sensor on the analytical
module, is outside of the control limits. Check
the regulated pressure at the bottle is at 90 PSI
(6.2 BarG). If the regulated pressure is OK, check
the connections on the Carrier Pressure Control
Valve and the pressure sensor. Refer to for help
with troubleshooting this issue.

Analog Input 1 High Signal

Analog Input 1 Low Signal

Analog Output 1 High Signal

Analog Output 1 Low Signal

Analog Output 2 High Signal

Analog Output 2 Low Signal

The value of the variable assigned to the analog
output is outside the range of the analog out-
put. If the value is valid, re-range the Analog
Output and the associated device that is receiv-
ing the signal so that the value of the variable is
within the range.

Stream 1 Validation Failure

Stream 2 Validation Failure

Stream 3 Validation Failure

Stream 4 Validation Failure

Stream 5 Validation Failure

The analysis of the validation gas for the associ-
ated stream is outside the allowable percent de-
viation, as defined in the Validation Data table.
Confirm that the Validation Gas concentration is
entered correctly in the validation data table. If
the concentrations are entered correctly, check
the validation run analysis results and chromato-
gram for analysis errors.

Stream 1 RF Deviation

Stream 2 RF Deviation

Stream 3 RF Deviation

Streams 1 to 3 should only be set to Analysis or
Unused. This alarm may occur If the streams are
incorrectly configured for calibration. To resolve
this error, start MON2020 and select Streams
on the Application menu. Set the stream’s Us-
age to Analysis or Unused.

Stream 4 RF Deviation The response factor for one or more compo-
nents have changed during a calibration run by a
percentage greater than set in the Component
Data Table. Check that the calibration gas con-
centration has been entered into the compo-
nent data table correctly, and confirm that the
calibration gas bottle is not empty or isolated. If
the concentrations are correct, the isolation
valves are open, and there is sufficient calibra-
tion gas pressure (higher than 20 PSI or 1.4 Bar),
check the calibration analysis and chromato-
grams for analytical errors.
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Alarm Description and Suggested Actions

Analyzer Board Comm Failure The communication link between the CPU
board and the analyzer board has failed. Re-
move power and confirm the analyzer board is
seated correctly on the back plane. If the ana-
lyzer board is seated correctly, replace the ana-
lyzer board. If replacing the analyzer board does
not rectify the issue, replace the back plane
board.

LOI Comm Failure The communication link between the CPU
Board and the Local Operator Interface (LOI) has
failed. Remove power and confirm the connec-
tors from the LOI are seated correctly in the
back plane. If the connectors are seated correct-
ly, replace the LOI. If replacing the LOI does not
rectify the issue, replace the back plane board.

Auto Valve Timing Failure The GC has taken too many analysis runs during
an Auto Valve Timing (AVT) routine without
finding the ideal valve timing. Confirm that the
Calibration Gas isolation valves are on and there
is greater than 10 PSI (0.7 Bar) of calibration gas.
Refer to for help with troubleshooting this issue.

Analytical Module Communication Failure The Intelligent Module board on the analytical
module is not communicating with the CPU
board.

Analytical Module Not Initialized The analytical module failed to initialize when
power was applied.

Module Validation Failure The analysis of the calibration gas failed during
the Module Validation process. Refer to for help
with troubleshooting this issue.

IMB Incompatible The firmware revision of the IMB is newer than
the firmware revision of the CPU board. Up-
grade the CPU firmware.

IMB CDT Component is missing in GC A component that is in the component data ta-
ble stored in a recently installed module is not
configured in the GC's existing component data
table. The component data table of the GC must
match (with the exception of neo-Pentane) the
component data table of a replacement mod-
ule.

Energy Value Invalid If enabled, the GC analyzes the calibration gas as
an unknown stream and computes its energy
value. The GC then compares this value to the
Cal Gas Cert CV and determines if the calibra-
tion gas' energy value is within the CV Check Al-
lowed Deviation. If it isn't, the GC triggers the
Energy Value Invalid alarm.
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Alarm Description and Suggested Actions

Stream 1 Ideal RF Deviation

Stream 2 Ideal RF Deviation

Stream 3 Ideal RF Deviation

Streams 1 to 3 should only be set to Analysis or
Not Used. This alarm may occur If the streams
are incorrectly configured for calibration. To re-
solve this error, start MON2020 and select
Streams on the Application menu. Set the
stream’s Usage to Analysis or Unused.

Stream 4 Ideal RF Deviation The response factor for one or more compo-
nents is outside of the limits of the Ideal Re-
sponse Factor check setting.

Stream 1 RF Out Of Order

Stream 2 RF Out Of Order

Stream 3 RF Out Of Order

Streams 1 to 3 should only be set to Analysis or
Not Used. This alarm may occur If the streams
are incorrectly configured for calibration. To re-
solve this error, start MON2020 and select
Streams on the Application menu. Set the
stream’s Usage to Analysis or Unused.

Stream 4 RF Out Of Order The response factors for one or more compo-
nents is not in the order of thermal conductivity
configured for natural gas applications.

Calibration Energy Value Check Fail The energy value calculated from the analysis
value of the calibration during a calibration cycle
is not within the limits of the energy value en-
tered from the calibration certificate.

Stored Data Integrity Failure Data associated with the GC’s measurement re-
sults and logs are stored in the GC along with a
16-bit cyclic redundancy check (CRC) code.
When the data is retrieved, its integrity is veri-
fied by recomputing the CRC code and compar-
ing it with the CRC code stored along with the
data. If there is a mismatch, then this alarm is
generated, and you should save the current con-
figuration and replace the CPU board.

n-Pentane RT Drift The retention time for the n-Pentane peak has
drifted too close to valve 3’s timing. This is typi-
cally due to contamination in the valves and in-
dicates the module should be exchanged and
overhauled soon.

Ethane RT Drift The retention time for the ethane peak has drif-
ted too close to the end of the analysis cycle.
This is typically due to contamination in the
valves and indicates the module should be ex-
changed and overhauled soon.
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8.2 Flowcharts
If you do not find help in the troubleshooting flowcharts, contact your local Rosemount
service representative.
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8.2.1 The GC won’t power up

Troubleshooting the 370XA

141



8.2.2 Un-normalized total error
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8.2.3 Carrier pressure alarms
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8.2.4 Heater won’t reach set point
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8.2.5 Module validation fails
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8.2.6 Auto valve timing fails
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